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Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user's guide describes the Math Library (MLIB) for the family of ARM Cortex M4 core-based microcontrollers. This library
contains optimized functions.

1.1.2 Data types

MLIB supports several data types: (un)signed integer, fractional , and accumulator. The integer data types are useful for
general-purpose computation; they are familiar to the MPU and MCU programmers. The fractional data types enable powerful
numeric and digital-signal-processing algorithms to be implemented. The accumulator data type is a combination of both; that
means it has the integer and fractional portions.

The following list shows the integer types defined in the libraries:

* Unsigned 16-bit integer—<0 ; 65535> with the minimum resolution of 1

» Signed 16-bit integer—<-32768 ; 32767> with the minimum resolution of 1

* Unsigned 32-bit integer—<0 ; 4294967295> with the minimum resolution of 1

» Signed 32-bit integer—<-2147483648 ; 2147483647> with the minimum resolution of 1
The following list shows the fractional types defined in the libraries:

+ Fixed-point 16-bit fractional—<-1 ; 1 - 2-15> with the minimum resolution of 2-15

+ Fixed-point 32-bit fractional—<-1 : 1 - 231> with the minimum resolution of 2-31
The following list shows the accumulator types defined in the libraries:

+ Fixed-point 16-bit accumulator—<-256.0 ; 256.0 - 277> with the minimum resolution of 27

« Fixed-point 32-bit accumulator—<-65536.0 ; 65536.0 - 2-15> with the minimum resolution of 2-15

1.1.3 API definition

MLIB uses the types mentioned in the previous section. To enable simple usage of the algorithms, their names use set prefixes
and postfixes to distinguish the functions' versions. See the following example:

f32Result = MLIB Mac_ F321ss (f32Accum, fl6Multl, fléMult2);

where the function is compiled from four parts:
* MLIB—this is the library prefix
* Mac—the function name—Multiply-Accumulate
* F32—the function output type

» Iss—the types of the function inputs; if all the inputs have the same type as the output, the inputs are
not marked

The input and output types are described in the following table:
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Table 1. Input/output types

Type Output Input
frac16_t F16 ]
frac32_t F32 I
acc32_t A32 a

1.1.4 Supported compilers

MLIB for the ARM Cortex M4 core is written in C language or assembly language with C-callable interface depending on the
specific function. The library is built and tested using the following compilers:

* MCUXpresso IDE
* IAR Embedded Workbench
» Keil pyVision
For the MCUXpresso IDE, the library is delivered in the mlib.a file.
For the Kinetis Design Studio, the library is delivered in the mi/ib.afile.
For the IAR Embedded Workbench, the library is delivered in the miib.afile.
For the Keil pVision, the library is delivered in the m/ib./ib file.

The interfaces to the algorithms included in this library are combined into a single public interface include file, m/ib.h. This is done
to lower the number of files required to be included in your application.

1.1.5 Library configuration

MLIB for the ARM Cortex M4 core is written in C language or assembly language with C-callable interface depending on the
specific function. Some functions from this library are inline type, which are compiled together with project using this library. The
optimization level for inline function is usually defined by the specific compiler setting. It can cause an issue especially when high
optimization level is set. Therefore the optimization level for all inline assembly written functions is defined by compiler pragmas
using macros. The configuration header file RTCESL_cfg.his located in: specific library folderIMLIBlInclude. The optimization
level can be changed by modifying the macro value for specific compiler. In case of any change the library functionality is

not guaranteed.

1.1.6 Special issues

1. The equations describing the algorithms are symbolic. If there is positive 1, the number is the closest number to 1 that
the resolution of the used fractional type allows. If there are maximum or minimum values mentioned, check the range
allowed by the type of the particular function version.

2. The library functions that round the result (the API contains Rnd) round to nearest (half up).

3. This RTCESL requires the DSP extension for some saturation functions. If the core does not support the DSP extension
feature the assembler code of the RTCESL will not be buildable. For example the core1 of the LPC55s69 has no DSP
extension.

1.2 Library integration into project (MCUXpresso IDE)

This section provides a step-by-step guide on how to quickly and easily include MLIB into any MCUXpresso SDK example or new
SDK project using MCUXpresso IDE. The SDK based project uses RTCESL from SDK package.

MLIB User's Guide, Rev. 5, 01 November 2021
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Adding RTCESL component to project

The MCUXpresso SDK package is necessary to add any example or new project and RTCESL component. In case the

package has not been downloaded go to mcuxpresso.nxp.com, build the final MCUXpresso SDK package for required board and
download it.

After package is dowloaded, open the MCUXpresso IDE and drag&drop the SDK package in zip format to the Installed SDK

window of the MCUXpresso IDE. After SDK package is dropped the mesage accepting window appears as can be show in
following figure.

B mic UXpresso IDE - [u}
File Edit Navigate Search Project Configlools Run RTOS Analysis Wi Help
Hmid | @~ &~ A2 N F-O0-Q-i® =R W BRZESR pHERDR
@0 i Ribi-Fl-oT et Q iR
[ Project Bx.. 51 i Registers % Faults &, Periphera.. = O =7
8% 7 | |- 8
There are ne projects in your werkspace.
To add a project:
B Creste s new MCUXpresso IDE C/C+ + project.
@ import examples from SDK. ) MCUxpresso IDE SDK import - ul 'Y
% Create s project...
Dy Import projects.. ‘."_ j Areyou sure you want to import the following SDK in the
&Y common ' maupresso’ folder?
D:ASDK_2_10_0_HVP-KV31F120Mzzip
@ inst.. 2 [ Prop.. [2 Pny ]
=]
[ Installed SDKs
(1) Quickstart Panel £ (x)= Variables ®g Breakpoints = [ Toinstallan SDK, simply drag and lpresy
. A [Installed SDKs . Available Board
- MCUXpresso IDE - Quickstart Panel B | B
0t No t selected Name
project selecte
~+ Create or import a project
p— B New project...
?a
Import SDK le(s)..
@ impo example(s) [] Do not ask for confirmation on SDK Drag and Drop install
® Import project(s) from file system...
~ Build your project
@ o[E ;
o {1 MCUX workspace o

Figure 1. MCUXpresso IDE - imporing the SDK package to MCUXpresso IDE

Click OK to confirm the SDK package import. Find the Quickstart panel in left bottom part of the MCUXpresso IDE and click New
project... item or Import SDK example(s)... to add rtcesl component to the project.
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() Installed SDKs

8 MCUX workspace - MCU¥presso IDE - O P4
File Edit MNavigate Search Project CenfigTools Run RIS Analysis Window Help
lmif = I®-4] - R H-O0-AU-id Y- RHETIDiN I ENEL RS ERDR
@il Ril-Fl-o e Q EA
[ Project Ex... 53 1! Registers 4% Faults &, Periphera.. = H =g
28lv|i#% B8
There are no projects in your workspace.
To add a project:
B8 Create a new MCUXpresso IDE C/C++ project.
B Import examples from SDK.
9 Create a project..
Eag lmport projects...
@mnst. 32 [OPop.. [ Probl. BCons.. MTem.. [gIma.. FiDebu. F, Offin. = B
®ox|d

(1) Quickstart Panel 57 (%)= Variables 9 Breskpoints = F  Toinstall an SDK, simply drag and drop an SDK (zip file/folder) into the ‘Installed SDKs' view. [Common 'mecuxpres:
MCUX \DE icketart Panel A [installed SDKs . Available Boards| Available Devices |
resso - Quickstart Panel
el P a Name SDK Version Manifest Version  Location
o project selected
HHSDK 2o HVP-KVITF120M | 2,10.0 380 T SOk 2100 FVB-Ky
~ Create or import a project

Invoke the new SDK project wizard

~ Build your project

@

~ SDK MCUs . Available boards

MCUs from installed SDKs. Please click

above or visit mcuxpresso.mxp.com to
obtain additional SDKs.

Please select an available board for your project.

[ Supported boards for device: MKV3TFS120012

vllx — >
Figure 2. MCUXpresso IDE - create new project or Import SDK example(s)
Then select your board, and clik Next button.
) 50K Wizard o x
(D) Cresting project for device: MKV31F5120012 using board: HVP-KV31F120M x @
. Board and/or Device selection page .

NP MKV3TF512300x12

v KV3x
MKV3TF512xxx12

hvpkv31£120m

~ Preinstalled MCUs
MCUs from preinstalled LPC and
generic Cortex-M part support
NXP PN7462AU-C3-00 "
PN7462AU-C2-00
PN7462AU-C3-00
Generic-MD
Generic-Moplus
Generic-M23
Generic-M3
Generic-M33
Generic-M4
Generie-M7

v

Selected Device: MKV31F512300¢12 using board: HVP-KV31F120M
Target Core: emd
Description:

SDKs for selected MCU
Name

Kinetis KV3x-100-120 MHz, Advanced 3ph FOC / Sensorless Motor Control MCUs

based on ARM Cortex-M4 2 SDK_2x_HVP-KVITF120M 2,100

@

SDK Version

Manifest Ve...
(49420C 3.8.0

Location

JE <Common>\SDK_2_10_0_HVP-KV:

< Back Finish Cancel

Figure 3. MCUXpresso IDE - selecting the board

Find the Middleware tab in the Components part of the window and click on the checkbox to be the rtcesl component ticked. Last

step is to click the Finish button and wait for project creating with all RTCESL libraries and include paths.
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3 soK Wizard u] X
i, The source from the SDK will be copied into the workspace. If you want to use linked files, please unzip the 'SDK_2x_HVP-KV31F120M' SDK. VA &
. Configure the project
Project neme: | MKV31F31212_FirstProject] * | Project name suffix:

Use default location

C:\MCUX_workspace\MKV31F51212_FirstProject Browse..
Device Packages Board Project Type Project Options
® MKV3IFS12VLLIZ ® Defaut board files @CProject (O Cr+ Project SDK Debug Console (3 Semihost @) UART
O MKV31F312VLH12 O Empty board files [ CMSIS-Core

(O Cstatic Library () C++ Static Library Copy sources

[ Import other files

Components [F] Components selection summary B

Add or remove SDK software components

[typetofitter |
Operating Systems |Drivers | CMSIS Drivers [ Utilities [ Middlewsre ._Board Components | Abstraction Layer | Software C:

Name Description  Ver... Info
Middleware B %l ®E £ Drivers
[typetofitter | £ Middleware
£ Operating Systems
Name Deseription Version Info £ Software Component
[ £ FreeMASTER £ Utilties
£ Memon
[1 = Motor Control
Real Time Control Embedded Software Library for CM... 110 | Real Time Control Embedded Software Library for CM4F core
@ <Back Next > Cancel

Figure 4. MCUXpresso IDE - selecting rtcesl component

Type the #include syntax into the code where you want to call the library functions. In the left-hand dialog, open the required .c
file. After the file opens, include the following line into the #include section:

#include "mlib.h"

When you click the Build icon (hammer), the project is compiled without errors.

1.3 Library integration into project (Keil pVision)

This section provides a step-by-step guide on how to quickly and easily include MLIB into an empty project or any
MCUXpresso SDK example or demo application projects using Keil pVision. This example uses the default installation path
(C:ANXP\RTCESL\CM4_RTCESL_4.7_KEIL). If you have a different installation path, use that path instead. If any MCUXpresso
SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read
next chapter.

NXP pack installation for new project (without MCUXpresso SDK)

This example uses the NXP MKV46F256xxx15 part, and the default installation path (C:\NXP\RTCESL\CM4_RTCESL_4.7_KEIL)
is supposed. If the compiler has never been used to create any NXP MCU-based projects before, check whether the NXP MCU
pack for the particular device is installed. Follow these steps:

1. Launch Keil yVision.

In the main menu, go to Project > Manage > Pack Installer....

In the left-hand dialog (under the Devices tab), expand the All Devices > Freescale (NXP) node.
Look for a line called "KVxx Series" and click it.

In the right-hand dialog (under the Packs tab), expand the Device Specific node.

o o~ 0D

Look for a node called "Keil::Kinetis_KVxx_DFP." If there are the Install or Update options, click the button to install/
update the package. See Figure 5.
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7. When installed, the button has the "Up to date" title. Now close the Pack Installer.

8 Pack Installer - C:\Keil ySARM\PACK —— - - -y =@ =]
File Packs Window Help
| e‘ Device: Freescale - Kvox Series
4 Devices | Boards | | |la] " Packs | Examples | |
‘ Search: - X Pack Action Description
= ey - Device Specific 1Pack
@ Atmel 257 Devices || o KeiKinetis Ko OFP [ nstall Freescale Kinetis Ko Series Device Support
@ Freescale 234 Devices El-Generic 10 Packs
% K Series 1 Device ARMECMSIS & Up to date | CMSIS (Cortex Microcontraller Software Interface Standard)
%2 K00 Series. 2 Devices KeilzARM_Compiler | Up to date | Keil ARM Compiler extensions
%2 K10 Series. 23 Devices Keil:lansson & Install__|Jansson is 5 C library for encoding, decoding and manipula
42 K20 Series. #1 Devices KeilsMDK-Middleware | & Update | Keil MDK-ARM Professional Middleware for ARM Cortex-M
%2 K30 Series. 6 Devices KeilzMDK-Network DS | & Install Keil MDK-ARM Professional Middleware Dual-Stack IPv4/IP
% K40 Series. 6 Devices WPz wIP & Instal IWIP is 2 light-weight implementation of the TCP/IP protoc
%2 K50 Series. 11 Devices Micrium:RTOS & Instal Micrium software components
%2 K60 Series. 18 Devices Ory & Instal Package (CycloneTCP, CyclonessL and Cyclon
%2 K70 Series. 3 Devices WoIfSSL:CyaSSL & Instal Light weight SSL/TLS and Crypt Library for Embedded Syste
%2 K80 Series. 2 Devices 1 VOGITECH:fRSTLAR... & Install | YOGITECH fRSTL Functional Safety EVAL Software Pack for
. KEAvo Series 6 Devices
Kb Series 11 Devices
Kl Series 54 Devices
A Koo Series 14 Devices
A Kiioc Series 26 Devices
. Koo Series 8 Devices
o pmiesns  fibee | 0
Output 3 x
Refresh Pack descriptions
Update available for Keil:MDK-Middleware (installed: 6.4.0, available: 7.0.0-beta)
| Ready Jonme
Figure 5. Pack Installer

New project (without MCUXpresso SDK)

To start working on an application, create a new project. If the project already exists and is opened, skip to the next section. Follow
these steps to create a new project:

1.
2.

N o o &

Launch Keil pVision.
In the main menu, select Project > New pVision Project..., and the Create New Project dialog appears.

Navigate to the folder where you want to create the project, for example C:\KeilProjects\MyProject01. Type the name of the
project, for example MyProject01. Click Save. See Figure 6.

Create New Project

File name:  MyProject0l

Save as type: |Project Files (“uvproj: ".uvprojs)

* Browse Folders

Figure 6. Create New Project dialog

In the next dialog, select the Software Packs in the very first box.

Type 'kv4' into the Search box, so that the device list is reduced to the KV4x devices.
Expand the KV4x node.

Click the MKV46F256xxx15 node, and then click OK. See Figure 7.
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- =
Select Device for Target 'Target 1°. u

ICPUl

ISoﬂware Packs LI

Vendor:  Freescale
Device:  MKV46F2560cc15

Toolset: ~ ARM
Search I
Description:
] MKVA3F128500d 5 :I The Kinetis K\4x family of MCUs is a high-performance solution for -
offering exceptional precision, sensing and control for the some of the
€ MKV43F6d0015 most demanding applications in motor and power contral.
1 MKVA4F1 285001 5 Built upon the ARM Cortex-M4 core running at 150 MHz with DSP and
Floating peint unit, it features dual 12-bit analogto-digital converters
€1 MKV44FEd0005 {ADCs) with 240 ns conversion time, eFexPWM medule with 312ps
g1 MKVASFL 28100d 5 resolution and ManoEdage support, up to 30 PWM channels for support
of multi-motor systems and dual AexCAN modules.
€1 MKV45F256:0015 | The Kinetis K\dx family is supported by a comprehensive enablement
2 MKVAEF1 281005 suite from Freescale and thind-party resources including reference
@ designs, software libraries and motor configuration tools.
4 -

Figure 7. Select Device dialog

8. In the next dialog, expand the Device node, and tick the box next to the Startup node. See Figure 8.

9. Expand the CMSIS node, and tick the box next to the CORE node.

Software Component Sel. Variant Version  Description
=4 cwmsis Cortex Micracontroller Saftware Interface Components
@ CORE I 410 CIMSIS-CORE for Cortex-M. 5C000, and SC300
@ Dse r 145 CIMSIS-DSP Library for Cortex-M. 5C000, and SC300
| € RTOS (AP]) 10 CMSIS-RTOS API for Cortex-M, SC000. and SC300
€ CMSIS Driver Unified Device Drivers compliant to CMSIS-Driver Specifications
& Compiler ARM Compiler Software Extensions
£ 4 Device Startup, System Setup
@ Startup I 100 System Startup for Kinetis KV45 150MHz devices devices devices
4 File System MDK-Pro 640 File Access on various storage devices
4 Graphics MDK-Pro 5261  Userlnterface on graphical LCD displays
& Network MDK-Pro 640 I Networking using Ethernet or Serial protocals
& use MDK-Pre G40 USE Communication with verious device classes

Figure 8. Manage Run-Time Environment dialog

10. Click OK, and a new project is created. The new project is now visible in the left-hand part of Keil yVision. See Figure 9.
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C jecls\Mﬁ'eﬁﬂ]\MEE’adﬂlwpmjx - uVision I

File Edit View Project Flash Debug Peripherals Too

NEdd| 4 a9 e

: E3

Project a E
=8 Project: MyProjectil
El@ Target1
ﬁ Source Group 1
& omsIs
El‘ Device
] startup_MKV46F15.s (Startup)
[ system_MKV46FL5.c (Startup)
[0 system_MKV46F15.h (Startup)

ﬂ | Target 1

Figure 9. Project

11. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.

12. Select the Target tab.

13. Select Not Used in the Floating Point Hardware option. See Figure 9.

—Code Generation
ARM Compiler: ILlse default compiler version ;I

[ Use Cross-Module Optimization
[ Use MicroLIB I EBig Endian
Floating Poirt Hardware: MNat Used -

Figure 10. FPU

Linking the files into the project

To include the library files in the project, create groups and add them.

1.

Right-click the Target 1 node in the left-hand part of the Project tree, and select Add Group... from the menu. A new group
with the name New Group is added.

Click the newly created group, and press F2 to rename it to RTCESL.
Right-click the RTCESL node, and select Add Existing Files to Group 'RTCESL'... from the menu.

Navigate into the library installation folder C:\NXP\RTCESL\CM4_RTCESL_4.7_KEIL\MLIB\Include, and select the m/ib.h
file. If the file does not appear, set the Files of type filter to Text file. Click Add. See Figure 11.
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Look in: I L Include j = % Ev
Mame Date modified I:
i | mlib.h 16.10.2014 9:19 [E

_ MLUB_Abs_Fl6.h 2110.2014 9:45

_ MLUB_Abs_F32.h 1610.2014 9:19

| MLIB_Add_&32.h 1610.2014 9:19

| MLIB_Add_F16.h 16.10.2014 9:19

| MLIB_Add_F32.h 16.10.2014 9:19

. MLIB_Add4_Fl6.h 16.10.2014 9:19

_ MLIB_Add4_F32.h 16.10.2014 9:19

_ MLIB_BiShift_F16.h 16.10.2014 2:19

_ MLIB_BiShift_F32.h 16.10.2014 219

RALTR il F4E L

-
440 N A AR

' I

File name: |mlib.h

r
Add I

Files of type: |Text file ("bd; *h; "inc)

Figure 11. Adding .h files dialog

| Close |

5. Navigate to the parent folder C:ANXP\RTCESL\CM4_RTCESL_4.7_KEIL\MLIB, and select the m/ib./ib file. If the file does

not appear, set the Files of type filter to Library file. Click Add. See Figure 12.

Look n: | |} MUIB

~| & ® ek B

MName Date modified Ty
. Include 20102014 15:37 Fi
|| | MLB.lib 16.10.2014 9:19 LI

< 1

3

File name: |I‘u'ILIE.Iib

Add I

Files of type: IIJblaryﬁle {*lib)

Figure 12. Adding .lib files dialog

~| Close |

6. Now, all necessary files are in the project tree; see Figure 13. Click Close.
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I Project
=% Project: MyProjectll
-4 Targetl
1 Source Group 1
=i RTCESL
_1 mlib.h
] MLB.Iib
& cmsis
=9 Device

Figure 13. Project workspace

Library path setup

The following steps show the inclusion of all dependent modules.

1. In the main menu, go to Project > Options for Target 'Target1'..., and a dialog appears.

2. Select the C/C++ tab. See Figure 14.

3. In the Include Paths text box, type the following path (if there are more paths, they must be separated by ';') or add it by

clicking the ... button next to the text box:
» "C:\NXP\RTCESL\CM4_RTCESL_4.7_KEIL\MLIB\Include"
4. Click OK.
5. Click OK in the main dialog.

Options for Target Target 1
De\ricel Target | Outputl Listingl User C/Cs+ |ﬁ5n1 I Linkerl Debug | Ltilities |

B
F

Symbals

Define: I

Undefine: I

 Language / Code Generation

I Strict ANSIC
Optimization: lm [ Enum Container always int
™ Optimize for Time ™ Plain Char is Signed
I~ Split Load and Store Multiple ™ Read-Only Posttion Independent
™ One ELF Section per Function I Read-Write Posttion Independert

Wamings

All Wamings -
= Thumb Mode

™ No Auto Includes
[ C99 Mode

Include ||
Paths

Misc I
Controls

Compiler | —cpu Cortex-M0+ -D__EVAL -g 00 -apcs=intenwork
control |- C:\KeilProjects\MyProjectD1\RTE
string

Defaults

Figure 14. Library path addition
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Type the #include syntax into the code. Include the library into a source file. In the new project, it is necessary to create a
source file:
1. Right-click the Source Group 1 node, and Add New ltem to Group 'Source Group 1'... from the menu.

2. Select the C File (.c) option, and type a name of the file into the Name box, for example 'main.c. See Figure 15.

-

Add New Item to Group "Source Group 1

Create a new C source file and add it to the projec
C |CFils{c)

@ C++ File  cpp)
\ﬂ Asm File (s)

\ﬂ Header File (h)
é Text File ()
jg\ Image File ()

Eo
1@ |Jser Code Template

Type:
Mame: | main. ¢
Location: | C:KeiProjects\MyProjectd1
Add Close
L

Figure 15. Adding new source file dialog

3. Click Add, and a new source file is created and opened up.

4. In the opened source file, include the following line into the #include section, and create a main function:
#include "mlib.h"

int main (void)
{

while (1) ;
}

When you click the Build (F7) icon, the project will be compiled without errors.

1.4 Library integration into project (IAR Embedded Workbench)

This section provides a step-by-step guide on how to quickly and easily include the MLIB into an empty project or any MCUXpresso
SDK example or demo application projects using IAR Embedded Workbench. This example uses the default installation path
(C:ANXP\RTCESL\CM4_RTCESL_4.7_IAR). If you have a different installation path, use that path instead. If any MCUXpresso
SDK project is intended to use (for example hello_world project) go to Linking the files into the project chapter otherwise read
next chapter.
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This example uses the NXP MKV46F256xxx15 part, and the default installation path (C:\NXP\RTCESL\CM4_RTCESL_4.7_IAR)
is supposed. To start working on an application, create a new project. If the project already exists and is opened, skip to the next

section. Perform these steps to create a new project:
1. Launch IAR Embedded Workbench.
2.

In the main menu, select Project > Create New Project... so that the "Create New Project" dialog appears. See Figure 16.

oo

| ARM

Toal chain:

Project templates:

=

[+ asm

[# C++

= C

- DLIB [, C++ with exceptions and RTTI]
- DLIB [C, Extended Embedded C++)

[l

Y TR S TRy Y P

——

Description:

 project using default tool zettings including an empty main. file,

[ o

] [ Cancel

Figure 16. Create New Project dialog

3. Expand the C node in the tree, and select the "main" node. Click OK.

4. Navigate to the folder where you want to create the project, for example, C:\IARProjects\MyProject01. Type the name of the
project, for example, MyProject01. Click Save, and a new project is created. The new project is now visible in the left-hand

part of IAR Embedded Workbench. See Figure 17.

& IAR Embedded Workbench IDE

Figure 17. New project

Eile Edit Yiew Project Simulater Teols Window Help

T IERE Y RS -4
L * | main.c |

[Debug v]
|| Files £ P

E¥5 |MyProjectd] -Deb__ | v | | return 0;

FrIdin. c * ]

L@ (1 Output

5.
6.

In the main menu, go to Project > Options..., and a dialog appears.

In the Target tab, select the Device option, and click the button next to the dialog to select the MCU. In this example, select

NXP > KV4x > NXP MKV46F256xxx15. Select None in the FPU option. Click OK. See Figure 18.
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Cateqary:

Static Analysis
Runtime Checking
C/C++ Compiler
Assembler
QOutput Converter
Custom Build
Build Actions
Linker
Debuager
Simulator
Angel
CMSIS DAP
GDE Server
TAR. ROM-monitor
T4et/TTAG]et
J-Link/1-Trace
TI Stellaris
Macraigor
PE micro
RDI
ST-LIMK
Third-Party Driver
TI XDS

,

=)

Target | Qutput | Library Configuration | Library Options | MISRAC:200/ « | »

Processor varant

|:::| Core Cortex-M4

@ Device  MXP MKVAGF2560015
Endian mode Floating point settings
@) Little FPU
Eig
BE3Z [ registers B
(@ BES

Adwvanced SIMD (NEON)

Figure 18. Options dialog

] [ Cancel

Library path variable

To make the library integration easier, create a variable that will hold the information about the library path.

1. In the main menu, go to Tools > Configure Custom Argument Variables..., and a dialog appears.

2. Click the New Group button, and another dialog appears. In this dialog, type the name of the group PATH, and click OK.

See Figure 19.
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Configure Custom Argument Variables

Workspace | Global

Enable Group
Troup...
MNew Group | 22 | E_ B
Fiable...
M : 3
ame PATH iable. ..
lete
oK l [ Cancel IF
prt...
Expand/Collapse All
[ Hide disabled groups
oK l l Cancel

A

Figure 19. New Group

3. Click on the newly created group, and click the Add Variable button. A dialog appears.

Type this name: RTCESL_LOC

To set up the value, look for the library by clicking the '..." button, or just type the installation path into the box:

C:\NXP\RTCESL\CM4_RTCESL_4.7_IAR. Click OK.
In the main dialog, click OK. See Figure 20.

# ' Configure Custom Argument Variables [ = |
Workspace | Global
[ pATH Disable Group
,
Add Variable ==
Name: |RTCESL_LOC |
Value: |C:WXP\,RTCESL_CM4_RTCESL_X.X_IAR| | I
OK. J[ Cancel ]

Figure 20. New variable

Linking the files into the project

To include the library files into the project, create groups and add them.

1.

Go to the main menu Project > Add Group...

. Type RTCESL, and click OK.

Click on the newly created node MLIB, and go to the main menu Project > Add Files... See Figure 22.

2
3. Click on the newly created node RTCESL, go to Project > Add Group..., and create a MLIB subgroup.

4.

5. Navigate into the library installation folder C:\NXP\RTCESL\CM4_RTCESL_4.7_IAR\MLIB\Include, and select the m/ib.h

file. (If the file does not appear, set the file-type filter to Source Files.) Click Open. See Figure 21.
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6. Navigate into the library installation folder C:\NXP\RTCESL\CM4_RTCESL_4.7_IAR\MLIB, and select the m/ib.afile. If the

file does not appear, set the file-type filter to Library / Object files. Click Open.

v Marme Date modified

 e— E— |
b Systern (C:) » NXP » RTCESL » CM4_RTCESL 43 IAR » MLIE » Include

Type

| . mlib.h 16.10.2015 9:38

H File

. MUB_Abs_Fl16.h 16.10.2015 9:38

Figure 21. Add Files dialog

H File

7. Now you will see the files added in the workspace. See Figure 22.

——
=
Y m
o
=
[fr}
4

-
0
)
1)
ey
ih
g

& G MyProjectd1 - Deb... v
FEICIRTCESL

| = O
| FH—DOMUBa

| L EImiibh

main.c *
L@ (3 Output

Figure 22. Project workspace

Library path setup
1. In the main menu, go to Project > Options..., and a dialog appears.

2. In the left-hand column, select C/C++ Compiler.

3. In the right-hand part of the dialog, click on the Preprocessor tab (it can be hidden in the right; use the arrow icons

for navigation).

4. In the text box (at the Additional include directories title), type the following folder (using the created variable):

+ $RTCESL_LOC$WMLIB\Include
5. Click OK in the main dialog. See Figure 23.
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Categony:
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General Options
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C/C++ Compiler
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Qutput Converter
Custom Build
Build Actions
Linker
Debugger
Simulator
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CMS3IS DAP
GDE Server
IAR ROM-monitor
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Third-Party Driver
TI XDS
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Preinclude file:
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.

[ Preprocessor output to file

Preserve comments

Generate Hine directives
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Figure 23. Library path adition

ak. ] [ Cahicel

Type the #include syntax into the code. Include the library included into the main.cfile. In the workspace tree, double-click the
main.cfile. After the main.cfile opens up, include the following line into the #include section:

#include

"mlib.h"

When you click the Make icon, the project will be compiled without errors.
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Chapter 2
Algorithms in detall

2.1 MLIB_Abs

The MLIB_Abs functions return the absolute value of the input. The function does not saturate the output. See the
following equation:

MLIB_Abs(x) = |x|
Figure 24. Algorithm formula

2.1.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_Abs function are shown in the following table.

Table 2. Function versions

Function name Input type Result type Description
MLIB_Abs_F16 frac16_t frac16_t Absolute value of a 16-bit fractional value. The output is within the range
<-1;1).
MLIB_Abs_F32 frac32_t frac32_t Absolute value of a 32-bit fractional value. The output is within the range
<-1;1).

2.1.2 Declaration
The available MLIB_Abs functions have the following declarations:
fracle t MLIB Abs Fl6(fracle t fleval)

frac32 t MLIB Abs F32(frac32 t f32Val)

2.1.3 Function use

The use of the MLIB_Abs function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static frac32 t f32val;

void main (void)
{
f32val = FRAC32(-0.354); /* £32val = -0.354 */

/* £32Result = [f32vVal]| */
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f32Result = MLIB Abs F32(f32Val);

2.2 MLIB_AbsSat

The MLIB_AbsSat functions return the absolute value of the input. The function saturates the output. See the following equation:

MLIB_AbsSat(x) = |x|
Figure 25. Algorithm formula

2.2.1 Available versions
This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.

The available versions of the MLIB_AbsSat function are shown in the following table.

Table 3. Function versions

Function name Input type Result type Description
MLIB_AbsSat_F16 frac16_t frac16_t Absolute value of a 16-bit fractional value. The output is within the range
<0;1).
MLIB_AbsSat_F32 frac32_t frac32_t Absolute value of a 32-bit fractional value. The output is within the range
<0;1).

2.2.2 Declaration
The available MLIB_AbsSat functions have the following declarations:
fraclé t MLIB AbsSat Fl6(fraclé t flé6Val)

frac32 t MLIB AbsSat F32(frac32 t f32val)

2.2.3 Function use

The use of the MLIB_AbsSat function is shown in the following example:

#include "mlib.h"

static fraclé6 t flé6Val, fl6Result;
void main (void)

{

flé6val = FRAC16(-0.835); /* fleval = -0.835 */

/% fl6Result = sat(|fl6vVall) */
fl6Result = MLIB AbsSat Fl6(fl6vVal);

2.3 MLIB_Add

The MLIB_Add functions return the sum of two addends. The function does not saturate the output. See the following equation:
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Figure 26. Algorithm formula

MLIB_Add(a,b) =a+b

2.3.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The result

may overflow.

» Accumulator output with fractional inputs - the output is the accumulator type, where the result can be out of the range <-1;
1). The inputs are the fractional values only.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1 ; 1).
The inputs are the accumulator and fractional values. The result may overflow.

The available versions of the MLIB_Add function are shown in the following table.

Table 4. Function versions

Function name

Input type

Result Description

Addend 1 Addend 2

type

MLIB_Add_F16 frac16_t frac16_t frac16_t | Addition of two 16-bit fractional addends. The output is within the
range <-1; 1).
MLIB_Add_F32 frac32_t frac32_t frac32_t | Addition of two 32-bit fractional addends. The output is within the

range <-1; 1).

MLIB_Add_A32ss

frac16_t frac16_t acc32_t | Addition of two 16-bit fractional addends; the result is a 32-bit

accumulator. The output may be out of the range <-2 ; 2>.

MLIB_Add_A32as

acc32_t frac16_t acc32_t | A 16-bit fractional addend is added to a 32-bit accumulator. The

output may be out of the range <-2 ; 2>.

2.3.2 Declaration

The available MLIB_Add functions have the following declarations:

fraclé_t MLIB Add F16(fraclé t f16Addl, fracl6 t f16Add2)
frac32 t MLIB Add F32(frac32_ t f32Addl, frac32 t f32Add2)
acc32 t MLIB Add A32ss(fracl6 t f16Addl, fraclé t f16Add2)
acc32_t MLIB Add_A32as(acc32_t a32Accum, fracl6_t fl6Add)

2.3.3 Function use

The use of the MLIB_Add function is shown in the following examples:

{
f16Addl

Fixed-point version:
#include "mlib.h"

static acc32 t a32Result;
static fracl6 t f16Addl,

void main (void)

= FRAC16(-0.8);

f16Add2;

/* fl6Addl = -0.8 */
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f16Add2 = FRAC16(-0.5); /* £16Add2 = -0.5 */

/* a32Result = fl16Addl + f16Add2 */
a32Result = MLIB Add A32ss(f16Addl, fl6Add2);

2.4 MLIB_AddSat

The MLIB_AddSat functions return the sum of two addends. The function saturates the output. See the following equation:

1, atb>1
MLIB_AddSat(a,b) ={ —1 atb<-1
atbh, else

Figure 27. Algorithm formula

2.4.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_AddSat function are shown in the following table.

Table 5. Function versions

Function name Input type Result Description

type

Addend 1 Addend 2

MLIB_AddSat_F16 |frac16_t frac16_t frac16_t | Addition of two 16-bit fractional addends. The output is within the
range <-1; 1).

MLIB_AddSat_F32 |frac32_t frac32_t frac32_t | Addition of two 32-bit fractional addends. The output is within the
range <-1; 1).

2.4.2 Declaration
The available MLIB_AddSat functions have the following declarations:
fracl6 t MLIB Add F16(fraclé t f16Addl, fraclé t f16Add2)

frac32 t MLIB Add F32(frac32 t £32Addl, frac32 t f£32Add2)

2.4.3 Function use

The use of the MLIB_AddSat function is shown in the following example:

#include "mlib.h"
static frac32 t f£32Addl, £f32Add2, f32Result;

void main (void)

{
£32Addl = FRAC32(-0.8); /* £32Add1
£32Add2 = FRAC32(-0.5); /* £32Add2

-0.8 */
=0.5 #/
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/* f32Result = sat (f32Addl + £32Add2) */
f32Result = MLIB AddSat F32(£f32Addl, £32Add2);

2.5 MLIB_Add4

The MLIB_Add4 functions return the sum of four addends. The function does not saturate the output. See the following equation:

MLIB Add4(a, b,c,d)=a+tb+c+d
Figure 28. Algorithm formula

2.5.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_Add4 function are shown in the following table.

Table 6. Function versions

Function name Input type Result Description

Add.1 | Add.2 | Add.3 | Add.a | DP®

MLIB_Add4_F16 |frac16_t |frac16_t |frac16_t |frac16_t |frac16_t | Addition of four 16-bit fractional addends. The
output is within the range <-1 ; 1).

MLIB_Add4_F32 |frac32_t |frac32_t |frac32_t |frac32_t |frac32_t | Addition of four 32-bit fractional addends. The
output is within the range <-1; 1).

2.5.2 Declaration

The available MLIB_Add4 functions have the following declarations:

fracl6e_t MLIB Add4 Flé6(fracl6 t fl6Addl, fraclé t fl6Add2, fraclé t f16Add3, fracl6 t f16Add4)

frac32 t MLIB Add4 F32(frac32 t £f32Addl, frac32 t £32Add2, frac32 t f£f32Add3, frac32 t f32Add4)

2.5.3 Function use

The use of the MLIB_Add4 function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static frac32 t f32Addl, f32Add2, f32Add3, f32Add4;
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{
£32Add1
£32Add2
£32Add3
£32Add4

void main (void)

= FRAC32(-0.3);
= FRAC32(0.5);
= FRAC32(-0.2);
= FRAC32(-0.4);

/*
/*
/*
/*

/* f£32Result = £32Addl + £32Add2
f32Result = MLIB Add4 F32 (£32Addl, f32Add2,

£32Add1l =
£f32Add2 =
£32Add3 =
f32Add4 =

+ f£32Add3 + £32Add4 */

=0.3 =/
0.5 */
-0.2 */
-0.4 */

£32Add3,

Algorithms in detail

£32Add4) ;

2.6 MLIB_Add4Sat

The MLIB_Add4Sat functions return the sum of four addends. The function saturates the output. See the following equation:

MLIB_Add4Sat(a, b,c,d) =

Figure 29. Algorithm formula

L
-1

atb+c+d,

atb+c+d>1
atb+c+d<-1

else

2.6.1 Available versions

This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.

The available versions of the MLIB_Add4Sat function are shown in the following table.

Table 7. Function versions

Function name Input type Result Description
Add.1 | Add.2 | Add.3 | Add.4 | OP°
MLIB_Add4Sat_F16 |frac16_t |frac16_t |frac16_t |frac16_t |frac16_t |Addition of four 16-bit fractional addends. The
output is within the range <-1; 1).
MLIB_Add4Sat_F32 frac32_t |frac32_t |frac32_t |frac32_t |frac32_t | Addition of four 32-bit fractional addends. The
output is within the range <-1; 1).

2.6.2 Declaration

The available MLIB_Add4Sat functions have the following declarations:

fracl6e_t MLIB_Add4Sat Fl6(fracl6_t f16Addl,

frac32 t MLIB Add4Sat F32(frac32 t £32Addl,

fraclé t f16Add2,

frac32 t £32Addz,

fracleé t f16Add3, fraclé6 t f16Add4)

frac32 t £32Add3, frac32 t f£32Add4)
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2.6.3 Function use

The use of the MLIB_Add4Sat function is shown in the following example:

#include "mlib.h"
static fracl6 t fl6Result, fl16Addl, f16Add2, fl16Add3, f1l6Add4;

void main (void)

{

f16Addl = FRAC16(-0.7); /* £16Addl = -0.7 */
f16Add2 = FRAC16(0.9); /* £16Add2 = 0.9 */
£f16Add3 = FRAC16(0.4); /* £16Add3 = 0.4 */
f16Add4 = FRAC16(0.7); /* fl6Add4 = 0.7 */

/* fl6Result = sat (f16Addl + f16Add2 + £16Add3 + f16Add4) */
fl6Result = MLIB Add4Sat F16(fl16Addl, fl6Add2, fl16Add3, fl6Add4);

2.7 MLIB_CIb
The MLIB_CIb functions return the number of leading bits of the input. If the input is 0, it returns the size of the type minus one.

2.7.1 Available versions
This function is available in the following versions:

* Integer output with fractional input - the output is the unsigned integer value when the input is fractional; the result is greater
than or equal to 0.

The available versions of the MLIB_CIb function are shown in the following table.

Table 8. Function versions

Function name Input type Result type Description

MLIB_CIb_U16s |frac16_t uint16_t Counts the leading bits of a 16-bit fractional value. The output is within the
range <0 ; 15>.

MLIB_CIb_U16l frac32_t uint16_t Counts the leading bits of a 32-bit fractional value. The output is within the
range <0 ; 31>.

2.7.2 Declaration
The available MLIB_CIb functions have the following declarations:
uintlé_t MLIB Clb Ulé6s(fracle t fléVal)

uintl6 t MLIB Clb U161 (frac32 t f£32Val)

2.7.3 Function use

The use of the MLIB_CIb function is shown in the following example:

#include "mlib.h"

static uintl6 t ul6Result;
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void main (void)

{

static frac32 t f32val;

f32vVal = FRAC32(0.00000452) ;

/* ul6Result = clb(f32val) */
ul6Result = MLIB Clb Ul6l (f32vVal);

Algorithms in detail

/* £32val = 0.00000452 */

2.8 MLIB_Conv

The MLIB_Conv functions return the input value, converted to the output type.

2.8.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1).

The available versions of the MLIB_Conv function are shown in the following table.

Table 9. Function versions

Function name Input type Result type Description
MLIB_Conv_F16l frac32_t frac16_t Conversion of a 32-bit fractional value to a 16-bit fractional value. The
output is within the range <-1; 1).
MLIB_Conv_F32s |frac16_t frac32_t Conversion of a 16-bit fractional value to a 32-bit fractional value. The
output is within the range <-1; 1).

2.8.2 Declaration
The available MLIB_Conv functions have the following declarations:
fracle_t MLIB Conv_F161 (frac32_t f£32Val)

frac32 t MLIB Conv_F32s(fracl6 t flé6Val)

2.8.3 Function use

The use of the MLIB_Conv function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static fraclé6 t flé6Val;

void main (void)
{

fl6vVal = FRAC16(-0.5); /* fleval = -0.5 */

/* f£32Result = (frac32 t)fl6val << 16 */
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f32Result = MLIB Conv_F32s(flé6Val);

2.9 MLIB_ConvSc

The MLIB_ConvSc functions return the input value converted to the output type using a scale coefficient.

2.9.1 Available versions
The function is available in the following versions:

 Fractional output - the output is the fractional portion of the result. The input value is divided by the scale to be within the range
<-1;1). The result may be saturated.

» Accumulator output - the output is the accumulator type, where the result may be out of the range <-1 ; 1).

 Floating-point output - the output is a floating-point number. The input value is multiplied by the scale to transform the fractional
value into the real floating-point number. The result is within the full range.

The available versions of the MLIB_ConvSc function are shown in the following table.

2.9.2 Declaration

The available MLIB_ConvSc functions have the following declarations:

2.9.3 Function use

The use of the MLIB_ConvSc function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static float t fltval, fltScale;

void main (void)

{

fltval = -0.25F; /* fltval = -0.25 */
fltScale = 10.0F; /* Scale is 10 */
/* f£32Result = (frac32 t) ((fltval / fltScale) * 2 ~ 31) */

f32Result = MLIB ConvSc F32ff (fltval, fltScale);

2.10 MLIB_Div

The MLIB_Div functions return the fractional division of the numerator and denominator. The function does not saturate the output.
See the following equation:
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Figure 30. Algorithm formula

MLIB Div(a b)={min,  a<0 A b=0

max, a>0 A b=0

% else

2.10.1 Awvailable versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The function is only
defined for: [nominator| < |[denominator|. The function returns undefined results out of this condition.

» Accumulator output - the output is the accumulator type, where the result may be out of the range <-1 ; 1).

The available versions of the MLIB_Div function are shown in the following table:

Table 11. Function versions

Function name Input type Result Description
e
Num. Denom. typ

MLIB_Div_F16 frac16_t |frac16_t |frac16_t | Division of a 16-bit fractional numerator and denominator. The output is
within the range <-1; 1).

MLIB_Div_F16ls frac32_t |frac16_t |frac16_t |Division of a 32-bit fractional numerator by a 16-bit fractional
denominator; the output is a 16-bit fractional result. The output is within
the range <-1; 1).

MLIB_Div_F16ll frac32_t |frac32_t |frac16_t | Division of a 32-bit fractional numerator and denominator; the output is
a 16-bit fractional result. The output is within the range <-1; 1).

MLIB_Div_F32Is frac32_t |frac16_t |frac32_t | Division of a 32-bit fractional numerator by a 16-bit fractional
denominator; the output is a 32-bit fractional result. The output is within
the range <-1; 1).

MLIB_Div_F32 frac32_t |frac32_t |frac32_t |Division of a 32-bit fractional numerator and denominator. The output is
within the range <-1; 1).

MLIB_Div_A32ss |frac16_t |frac16_t |acc32_t | Division of a 16-bit fractional numerator and denominator; the output
is a 32-bit accumulator result. The output may be out of the range
<-65536 ; 65536).

MLIB_Div_A32Is frac32_t |frac16_t |acc32_t |Division of a 32-bit fractional numerator by a 16-bit fractional
denominator; the output is a 32-bit accumulator result. The output may
be out of the range <-65536 ; 65536).

MLIB_Div_A32ll frac32_t |frac32_t |acc32_t |Division of a 32-bit fractional numerator and denominator; the output
is a 32-bit accumulator result. The output may be out of the range
<-65536 ; 655306).

MLIB_Div_A32as |acc32_t |frac16_t |acc32_t |Division of a 32-bit accumulator numerator by a 16-bit fractional
denominator; the output is a 32-bit accumulator result. The output may
be out of the range <-65536 ; 65536).

2.10.2 Declaration

The available MLIB_Div functions have the following declarations:

fraclé t MLIB Div F16(fracl6 t f16Num,
fraclé t MLIB Div Fl6ls(frac32 t £32Num,

fraclé t fléDenom)
fracle t flé6Denom)
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fraclé t MLIB Div F1611 (frac32 t £32Num, frac32 t f32Denom)
frac32 t MLIB Div_F321s(frac32 t f32Num, fracl6 t flé6Denom)
frac32 t MLIB Div F32(frac32 t £f32Num, frac32 t f32Denom)

acc32 t MLIB Div A32ss(fracl6 t fl6Num, fracl6 t fl6Denom)
acc32_t MLIB Div_A321s(frac32_t f£32Num, fracl6_t fléDenom)
acc32 t MLIB Div_A3211(frac32 t f£32Num, frac32 t f32Denom)
acc32_t MLIB Div_A32as(acc32 t a32Num, fraclé t fléDenom)

2.10.3 Function use

The use of the MLIB_Div function is shown in the following examples:

Algorithms in detail

Fixed-point version:

#include "mlib.h"

static frac32 t £32Num, f32Result;
static fracl6 t flé6Denom;

void main (void)

{

£32Num = FRAC32(0.2); /* £32Num = 0.2 */
fl6Denom = FRAC16(-0.495); /* fl6éDenom = -0.495 */

/* f32Result = f32Num / fl6Denom */
f32Result = MLIB Div F321s (£32Num, fl6Denom) ;

2.11 MLIB_DivSat

The MLIB_DivSat functions return the fractional division of the numerator and denominator. The function saturates the output. See
the following equation:

a

max, 5 >max V¥V a>0 A b=0

MLIB_DivSat(a, b) = { min, $<min V a<0 A b=0

]
b»

Figure 31. Algorithm formula

else

2.11.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

» Accumulator output - the output is the accumulator type, where the result may be out of the range <-65536 ; 65536).

The available versions of the MLIB_DivSat function are shown in the following table:
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Function name

Input type

Result

Num. Denom.

type

Description

MLIB_DivSat_F16

frac16_t |frac16_t |frac16_t

Division of a 16-bit fractional numerator and denominator. The output
is within the range <-1; 1).

MLIB_DivSat_F16ls

frac32_t |frac16_t |frac16_t

Division of a 32-bit fractional numerator by a 16-bit fractional
denominator; the output is a 16-bit fractional result. The output is
within the range <-1; 1).

MLIB_DivSat_F16ll

frac32_t |frac32_t |frac16_t

Division of a 32-bit fractional numerator and denominator; the output
is a 16-bit fractional result. The output is within the range <-1; 1).

MLIB_DivSat_F32Is

frac32_t |frac16_t |frac32_t

Division of a 32-bit fractional numerator by a 16-bit fractional
denominator; the output is a 32-bit fractional result. The output is
within the range <-1; 1).

MLIB_DivSat_F32

frac32_t |frac32_t |frac32_t

Division of a 32-bit fractional numerator and denominator. The output
is within the range <-1; 1).

MLIB_DivSat_A32as

acc32_t |frac16_t |acc32_t

Division of a 32-bit accumulator numerator by a 16-bit fractional
denominator; the output is a 32-bit accumulator result. The output
may be out of the range <-65536 ; 65536).

2.11.2 Declaration

The available MLIB_DivSat functions have the following declarations:

fraclé t MLIB DivSat F16(fraclé t fl16Num,
fraclé t MLIB DivSat Fl6ls(frac32 t f£32Num,
fraclé_t MLIB DivSat F1611(frac32 t f32Num,
frac32 t MLIB DivSat F321s(frac32_ t £32Num,
frac32_t MLIB _DivSat F32(frac32_t f32Num,
acc32_t MLIB DivSat_ A32as(acc32_t a32Num,

2.11.3 Function use

fraclé t fléDenom)
fracle t flé6Denom)
frac32 t f32Denom)
fracle_t flé6Denom)
frac32_t f32Denom)
fraclé t fléDenom)

The use of the MLIB_DivSat function is shown in the following example:

#include

{
£32Num

static frac32_t f£32Num,

£32Denom

"mlib.h"

void main (void)

FRAC32(0.4);
FRAC32 (-0.02) ;

f32Denom,

/* £32Num = 0.4 */
/* £32Denom = -0.02 */

/* f£32Result = £32Num / £32Denom */
f32Result

= MLIB DivSat F32 (£32Num,

f32Result;

£32Denom) ;
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2.12 MLIB_Div1Q

The MLIB_Div1Q functions return the single-quadrant fractional division of the numerator and denominator. The numerator and
denominator must be non-negative numbers, otherwise the function returns undefined results. The function does not saturate the
output. See the following equation:

max, a>0 A b=0

MLIB DivlQ(a, b) = g 430 A b>0

Figure 32. Algorithm formula

2.12.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The function is only
defined for: nominator < denominator, and both are non-negative. The function returns undefined results out of this condition.

» Accumulator output - the output is the accumulator type, where the result is greater than or equal to 0.

The available versions of the MLIB_Div1Q function are shown in the following table:

Table 13. Function versions

Function name Input type Result Description
e
Num. Denom. typ
MLIB_DiviQ_F16 frac16_t |frac16_t |frac16_t | Division of a non-negative 16-bit fractional numerator and

denominator. The output is within the range <0 ; 1).

MLIB_Div1Q_F16ls frac32_t |frac16_t |frac16_t | Division of a non-negative 32-bit fractional numerator by a non-
negative 16-bit fractional denominator; the output is a non-negative
16-bit fractional result. The output is within the range <0 ; 1).

MLIB_Div1Q_F16ll frac32_t |frac32_t |frac16_t | Division of a non-negative 32-bit fractional numerator and
denominator; the output is a non-negative 16-bit fractional result.
The output is within the range <0 ; 1).

MLIB_Div1Q_F32Is frac32_t |frac16_t |frac32_t | Division of a non-negative 32-bit fractional numerator by a non-
negative 16-bit fractional denominator; the output is a non-negative
32-bit fractional result. The output is within the range <0 ; 1).

MLIB_Div1Q_F32 frac32_t |frac32_t |frac32_t |Division of a non-negative 32-bit fractional numerator and
denominator. The output is within the range <0 ; 1).

MLIB_Div1Q_A32ss |frac16_t |frac16_t |acc32_t |Division of a non-negative 16-bit fractional numerator and
denominator; the output is a non-negative 32-bit accumulator result.
The output is greater than or equal to 0.

MLIB_Div1Q_A32ls frac32_t |frac16_t |acc32_t |Division of a non-negative 32-bit fractional numerator by a non-
negative 16-bit fractional denominator; the output is a non-negative
32-bit accumulator result. The output is greater than or equal to 0.

MLIB_Div1Q_A32lII frac32_t |frac32_t |acc32_t |Division of a non-negative 32-bit fractional numerator and
denominator; the output is a non-negative 32-bit accumulator result.
The output is greater than or equal to 0.

MLIB_Div1iQ_A32as |acc32_t |frac16_t |acc32_t |Division of a non-negative 32-bit accumulator numerator by a
non-negative 16-bit fractional denominator; the output is a 32-bit
accumulator result. The output is greater than or equal to 0.
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2.12.2 Declaration

The available MLIB_Div1Q functions have the following declarations:

fraclé t MLIB DivlQ F16(fraclé t fl16Num, fracl6 t fl6Denom)
fraclé t MLIB DivlQ Fl6ls(frac32 t f£32Num, fraclé t fléDenom)
fraclé _t MLIB DivlQ F1611(frac32 t f£32Num, frac32 t f32Denom)
frac32 t MLIB DivlQ F321s(frac32 t f£32Num, fracl6 t fléDenom)
frac32 t MLIB Divl1Q F32(frac32 t f£32Num, frac32 t £32Denom)
acc32_t MLIB DivlQ A32ss(fracl6_t f1l6Num, fracl6_t fl6Denom)
acc32 t MLIB DivlQ A321s(frac32 t £32Num, fracl6 t fl6Denom)
acc32_t MLIB DivlQ A3211 (frac32 t £32Num, frac32 t f32Denom)
acc32_t MLIB DivlQ A32as(acc32 t a32Num, fraclé6 t fléDenom)

2.12.3 Function use

The use of the MLIB_Div1Q function is shown in the following example:

#include "mlib.h"
static frac32 t £32Num, f32Denom, f32Result;

void main (void)

{
£32Num = FRAC32(0.2); /* £32Num = 0.2 */
f32Denom = FRAC32(0.865) ; /* f£32Denom = 0.865 */

/* f32Result = f32Num / f32Denom */
f32Result = MLIB Div1Q F32 (£32Num, f32Denom) ;

2.13 MLIB_Div1QSat

The MLIB_Div1QSat functions return the fractional division of the numerator and denominator. The numerator and denominator
must be non-negative numbers. The function saturates the output. See the following equation:

MLIB DivIOS b ax, %>max A a>0 A b>0
t =
-DiviQSat(a. b) % a>0 A b>0

Figure 33. Algorithm formula

2.13.1 Available versions

This function is available in the following versions:
 Fractional output - the output is the fractional portion of the result; the result is within the range <0 ; 1). The result may saturate.
» Accumulator output - the output is the accumulator type, where the result is greater than or equal to 0.

The available versions of the MLIB_Div1QSat function are shown in the following table:
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Function name

Input type

Num. Denom.

Result
type

Description

MLIB_Div1QSat_F16

frac16_t |frac16_t

frac16_t

Division of a non-negative 16-bit fractional numerator and
denominator. The output is within the range <0 ; 1).

MLIB_Div1QSat_F16ls

frac32_t |frac16_t

frac16_t

Division of a non-negative 32-bit fractional numerator by a
non-negative 16-bit fractional denominator; the output is a non-
negative 16-bit fractional result. The output is within the range
<0;1).

MLIB_Div1QSat_F16ll

frac32_t |frac32_t

frac16_t

Division of a non-negative 32-bit fractional numerator and
denominator; the output is a non-negative 16-bit fractional result.
The output is within the range <0 ; 1).

MLIB_Div1QSat_F32Is

frac32_t |frac16_t

frac32_t

Division of a non-negative 32-bit fractional numerator by a
non-negative 16-bit fractional denominator; the output is a non-
negative 32-bit fractional result. The output is within the range
<0; 1).

MLIB_Div1QSat_F32

frac32_t |frac32_t

frac32_t

Division of a non-negative 32-bit fractional numerator and
denominator. The output is within the range <0 ; 1).

MLIB_Div1QSat_A32as

acc32_t |frac16_t

acc32_t

Division of a non-negative 32-bit accumulator numerator by a
non-negative 16-bit fractional denominator; the output is a 32-bit
accumulator result. The output is greater than or equal to 0.

2.13.2 Declaration

The available MLIB_Div1QSat functions have the following declarations:

fracle t
fracle t
fracle_t
frac32 t
frac32 t

2.13.3 Function use

MLIB DivlQSat F16 (fraclé t fl6Num,
MLIB DivlQSat Fl6ls(frac32 t £32Num,
MLIB DivlQSat F1611 (frac32 t f32Num,
MLIB DivlQSat F321s(frac32_t f£32Num,
MLIB_DivlQSat_ F32(frac32_t f32Num,
acc32_t MLIB DivlQSat A32as(acc32_t a32Num,

fraclé t fléDenom)
fracle t flé6Denom)
frac32 t f32Denom)
fracle_t flé6Denom)
frac32_t f32Denom)
fraclé t fléDenom)

The use of the MLIB_Div1QSat function is shown in the following example:

#include

void main (void)
{
£32Num =
fl6Denom =

/* f32Result

"mlib.

static frac32_t f£32Num,
static fracl6_t flé6Denom;

h"

FRAC32(0.02) ;
FRAC16(0.4);

= f32Num / fl6Denom

/*
/*

f32Result;

£32Num = 0.02 */
fl6Denom = 0.4 */
)
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f32Result = MLIB DivlQSat F321s(£32Num, flé6Denom) ;

2.14 MLIB_Log2

The MLIB_Log2 functions return the binary logarithm of the input. See the following equation:

0, x<l1
MLIB_Lng(.X) = Lng(X), else

Figure 34. Algorithm formula

2.14.1 Available versions
This function is available in the following versions:
» Unsigned integer output - the output is the unsigned integer result.

The available versions of the MLIB_Log?2 function are shown in the following table.

Table 15. Function versions

Function name Input type Result type Description

MLIB_Log2_U16 |uint16_t uint16_t Binary logarithm of a 16-bit unsigned integer value. The output is greater
than or equal to 0.

2.14.2 Declaration

The available MLIB_Log2 functions have the following declarations:

uintl6é t MLIB Log2 Ul6(uintl6 t uléVal)

2.14.3 Function use

The use of the MLIB_Log2 function is shown in the following example:

#include "mlib.h"

static uintl6 t ul6Result, ulé6Val;
void main (void)

{

uleval = 5; /* uleval = 5 */

/* ul6Result = log2 (ul6vVal) */
ul6Result = MLIB Log2 Ulé6 (uléVval);

2.15 MLIB_Mac

The MLIB_Mac functions return the sum of the input accumulator, and the fractional product of two multiplicands. The function
does not saturate the output. See the following equation:
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MLIB Mac(a,b,c)=a+b-c
Figure 35. Algorithm formula

2.15.1 Available versions
This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1; 1).
The accumulator is the accumulator type, the multiplicands are the fractional types. The result may overflow.

The available versions of the MLIB_Mac function are shown in the following table.

Table 16. Function versions

Function name Input type Result Description

type

Accum. Mult. 1 Mult. 2

MLIB_Mac_F16 frac16_t |frac16_t |frac16_t |frac16_t | The upper 16-bit portion [16..31] of the fractional product
(of two 16-bit fractional multiplicands) is added to a 16-bit
fractional accumulator. The output is within the range
<-1;1).

MLIB_Mac_F32Iss frac32_t |frac16_t |frac16_t |frac32_t | The 32-bit fractional product (of two 16-bit fractional
multiplicands) is added to a 32-bit fractional accumulator.
The output is within the range <-1; 1).

MLIB_Mac_F32 frac32_t |frac32_t |frac32_t |frac32_t | The upper 32-bit portion [32..63] of the fractional product
(of two 32-bit fractional multiplicands) is added to a 32-bit
fractional accumulator. The output is within the range
<-1;1).

MLIB_Mac_A32ass acc32_t |[frac16_t |frac16_t |acc32_t | The upper 16-bit portion [16..31] of the fractional product
(of two 16-bit fractional multiplicands) is added to a 32-
bit accumulator. The output may be out of the range
<-65536 ; 65536).

2.15.2 Declaration

The available MLIB_Mac functions have the following declarations:

fracle_t MLIB Mac F16(fracl6_t fl6Accum, fracl6_t fleMultl, fracle_t fleMult2)
frac32 t MLIB Mac F321ss(frac32 t £f32Accum, fracl6 t fleMultl, fraclée t fleMult2)
frac32 t MLIB Mac F32(frac32 t f32Accum, frac32 t f£32Multl, frac32 t f£32Mult2)
acc32_t MLIB Mac_A32ass (acc32_t a32Accum, fracl6 t fleMultl, fracle t fleMult2)

2.15.3 Function use

The use of the MLIB_Mac function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t £32Accum, f32Result;
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static fraclé t fl6Multl, fleMult2;

void main (void)

{

f32Accum = FRAC32(0.3); /* £32Accum = 0.3 */
fléMultl = FRAC16(0.1); /* fl6Multl = 0.1 */
fléMult2 = FRAC16(-0.2); /* fl6Mult2 = -0.2 */

/* f32Result = f32Accum + flé6Multl * fléeMult2 */
f32Result = MLIB Mac F321ss(f32Accum, fl6Multl, fl6Mult2);

2.16 MLIB_MacSat

The MLIB_MacSat functions return the sum of the input accumulator and the fractional product of two multiplicands. The function
saturates the output. See the following equation:

1, atbec>1
MLIB MacSat(a, b,c) ={ —L atbec<-1
atbec, else

Figure 36. Algorithm formula

2.16.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_MacSat function are shown in the following table.

Table 17. Function versions

Function name Input type Result Description
Accum. | Mut1 | Mut2 | YPe
MLIB_MacSat_F16 frac16_t |frac16_t |frac16_t |frac16_t | The upper 16-bit portion [16..31] of the fractional

product (of two 16-bit fractional multiplicands) is added
to a 16-bit fractional accumulator. The output is within
the range <-1; 1).

MLIB_MacSat_F32Iss frac32_t |frac16_t |frac16_t |frac32_t | The 32-bit fractional product (of two 16-bit fractional
multiplicands) is added to a 32-bit fractional
accumulator. The output is within the range <-1; 1).

MLIB_MacSat_F32 frac32_t |frac32_t |frac32_t |frac32_t | The upper 32-bit portion [32..63] of the fractional
product (of two 32-bit fractional multiplicands) is added
to a 32-bit fractional accumulator. The output is within
the range <-1; 1).
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2.16.2 Declaration
The available MLIB_MacSat functions have the following declarations:
fraclé_t MLIB MacSat Fl6(fracl6 t fl6Accum, fracl6 t fleMultl, fraclée t fleMult2)

frac32 t MLIB MacSat F32lss(frac32 t f32Accum, fracl6 t fle6Multl, fraclé6 t fleMult2)
frac32 t MLIB MacSat F32(frac32 t f32Accum, frac32_ t f32Multl, frac32 t f32Mult2)

2.16.3 Function use

The use of the MLIB_MacSat function is shown in the following example:

#include "mlib.h"

static fraclé t fl6Multl, fleMult2;
static frac32 t f32Accum, f32Result;

void main (void)

{

f32Accum = FRAC32(-0.7); /* £32Accum = -0.7 */
fl6Multl = FRAC16(-1.0); /* fleMultl = -1.0 */
fléMult2 = FRAC16(0.8); /* fleMult2 = 0.8 */

/* f£32Result = sat (f32Accum + fl6Multl * fleMult2) */
f32Result = MLIB MacSat F321ss(f32Accum, flé6Multl, fl6Mult2);

2.17 MLIB_MacRnd

The MLIB_MacRnd functions return the sum of the input accumulator and the rounded fractional product of two multiplicands. The
round method is the round to nearest. The function does not saturate the output. See the following equation:

MLIB MacRnd(a, b,c) =a+round(bec)

Figure 37. Algorithm formula

2.17.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

» Accumulator output with mixed inputs - the output is the accumulator type where the result can be out of the range <-1; 1).
The accumulator is the accumulator type, the multiplicands are the fractional types. The result may overflow.

The available versions of the MLIB_MacRnd function are shown in the following table.

Table 18. Function versions

Function name Input type Result Description

Accum. | Mult.1 | Mut2 | ¥Pe

MLIB_MacRnd_F16 frac16_t |frac16_t |frac16_t |frac16_t | The fractional product (of two 16-bit fractional
multiplicands), rounded to the upper 16 bits, is added

Table continues on the next page...
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Table 18. Function versions (continued)

Function name Input type Result Description

Accum. | Mult.1 | Mut2 | YPe

to a 16-bit fractional accumulator. The output is within
the range <-1; 1).

MLIB_MacRnd_F32lis frac32_t |frac32_t |frac16_t |frac32_t | The fractional product (of a 32-bit and 16-bit fractional
multiplicand), rounded to the upper 32 bits [16..48], is
added to a 32-bit fractional accumulator. The output is
within the range <-1; 1).

MLIB_MacRnd_F32 frac32_t |frac32_t |frac32_t |frac32_t | The fractional product (of two 32-bit fractional
multiplicands), rounded to the upper 32 bits [32..63], is
added to a 32-bit fractional accumulator. The output is
within the range <-1; 1).

MLIB_MacRnd_A32ass acc32_t |[frac16_t |frac16_t |acc32_t | The fractional product (of two 16-bit fractional
multiplicands), rounded to the upper 16 bits [16..31], is
added to a 32-bit accumulator. The output may be out
of the range <-65536 ; 65536).

2.17.2 Declaration

The available MLIB_MacRnd functions have the following declarations:

fraclé_t MLIB MacRnd Fl6(fraclé t fl6Accum, fraclé t fléeMultl, fraclé t fleMult2)
frac32 t MLIB MacRnd F3211s(frac32 t f32Accum, frac32 t f£f32Multl, fraclé t fl6Mult2)
frac32 t MLIB MacRnd F32(frac32 t f32Accum, frac32 t £32Multl, frac32 t £32Mult2)
acc32 t MLIB MacRnd A32ass(acc32 t a32Accum, fracl6 t fleMultl, fracl6 t fleMult2)

2.17.3 Function use

The use of the MLIB_MacRnd function is shown in the following example:

#include "mlib.h"

static fracl6é t fl6Accum, fl6Multl, flé6Mult2, fl6Result;

void main (void)

{

fl6Accum = FRAC16(0.3); /* fl6Accum = 0.3 */
fl6Multl = FRAC16(0.1); /* fleMultl = 0.1 */
fl6Mult2 = FRAC16(-0.2); /* floeMult2 = -0.2 */

/* fl6Result = round(fl6Accum + fl6Multl * fl6Mult2) */
fl6Result = MLIB MacRnd F16 (fl6Accum, flé6Multl, fl6Mult2);

2.18 MLIB_MacRndSat

The MLIB_MacRndSat functions return the sum of the input accumulator and the rounded fractional product of two multiplicands.
The round method is the round to nearest. The function saturates the output. See the following equation:
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L a+round(bec)>1
MLIB_MacRndSat(a, b, ¢) = -1, a+round(bec) <-1
a+round(bec), else

Figure 38. Algorithm formula

2.18.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_MacRndSat function are shown in the following table.

Table 19. Function versions

Function name Input type Result Description

type

Accum. Mult. 1 Mult. 2

MLIB_MacRndSat_F16 frac16_t |frac16_t |frac16_t |frac16_t | The fractional product (of two 16-bit fractional
multiplicands), rounded to the upper 16 bits, is
added to a 16-bit fractional accumulator. The output
is within the range <-1; 1).

MLIB_MacRndSat_F32lls frac32_t |frac32_t |frac16_t |frac32_t | The fractional product (of a 32-bit and 16-bit
fractional multiplicands), rounded to the upper

32 bits [16..48], is added to a 32-bit fractional
accumulator. The outputis within the range <-1; 1).

MLIB_MacRndSat_F32 frac32_t |frac32_t |frac32_t |frac32_t | The fractional product (of two 32-bit fractional
multiplicands), rounded to the upper 32 bits
[32..63], is added to a 32-bit fractional accumulator.
The output is within the range <-1 ; 1).

2.18.2 Declaration

The available MLIB_MacRndSat functions have the following declarations:

fraclé t MLIB MacRndSat F16(fracl6 t fl6Accum, fracl6 t fle6Multl, fraclé6 t fleMult2)
frac32 t MLIB MacRndSat F3211ls(frac32 t f32Accum, frac32 t f32Multl, fraclé t fleéeMult2)
frac32 t MLIB MacRndSat F32(frac32 t f32Accum, frac32 t £32Multl, frac32 t £32Mult2)

2.18.3 Function use

The use of the MLIB_MacRndSat function is shown in the following example:

#include "mlib.h"
static frac32 t f32Accum, f32Multl, £32Mult2, f32Result;

void main (void)

{

£f32Accum = FRAC32(-0.7); /* £32Accum = -0.7 */
£32Multl = FRAC32(-1.0); /* £32Multl = -1.0 */
£f32Mult2 = FRAC32(0.8); /* £32Mult2 = 0.8 */
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/* f32Result = sat (round(f32Accum + f£32Multl * £32Mult2)) */
f32Result = MLIB MacRndSat F32 (f32Accum, f£32Multl, £32Mult2);

2.19 MLIB_Mac4

The MLIB_Mac4 functions return the sum of two products of two pairs of multiplicands. The function does not saturate the output.
See the following equation:

MLIB Mac4(a,b,c,d) =a*b+ced
Figure 39. Algorithm formula

2.19.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_Mac4 function are shown in the following table.

Table 20. Function versions

Function name Input type Result Description

type

Product 1 Product 2
Mult. 1 Mult. 2 Mult. 1 Mult. 2

MLIB_Mac4_F32ssss frac16_t |frac16_t |frac16_t |frac16_t |frac32_t |Addition of two 32-bit fractional products
(of two 16-bit fractional multiplicands). The
output is within the range <-1 ; 1).

2.19.2 Declaration

The available MLIB_Mac4 functions have the following declarations:

frac32 t MLIB Mac4 F32ssss(fracl6_t f16AddlMultl, fracl6 t fl6AddlMult2, fraclé t fl6Add2Multl,
fracl6e t fl16Add2Mult2)

2.19.3 Function use

The use of the MLIB_Mac4 function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static fraclé t fl16AddiMultl, f16AddlMult2, fl6Add2Multl, fl16Add2Mult2;
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void main (void)

{

f16Add1lMultl = FRAC16(0.2); /* fl16Add1Multl = 0.2 */
f16Add1lMult2 = FRAC16(-0.7); /* £f16Add1Mult2 = -0.7 */
f16Add2Multl = FRAC16(0.3); /* £16Add2Multl = 0.3 */
f16Add2Mult2 = FRAC16 (-0.25); /* £16Add2Mult2 = -0.25 */

/* f£32Result = f16AddlMultl * f16AddIlMult2 + fl6Add2Multl * fl6Add2Mult2*/
f32Result = MLIB Mac4 F32ssss(fl16AddlMultl, fl6AddlMult2, fl16Add2Multl,
fl6Add2Mult2) ;
}

2.20 MLIB_Mac4Sat

The MLIB_Mac4Sat functions return the sum of two products of two pairs of multiplicands. The function saturates the output. See
the following equation:

1, asb+ced>1
MLIB Mac4Sat(a, b, c,d) = -1 asb+ced<-1
a*b+ced, else

Figure 40. Algorithm formula

2.20.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_Mac4Sat function are shown in the following table.

Table 21. Function versions

Function name Input type Result Description

type

Product 1 Product 2

Muilt. 1 Mult.2 | Mult. 1 Mult. 2

MLIB_Mac4Sat_F32ssss frac16_t |frac16_t |frac16_t |frac16_t |frac32_t | Addition of two 32-bit fractional products
(of two 16-bit fractional multiplicands).
The output is within the range <-1; 1).

2.20.2 Declaration

The available MLIB_Mac4Sat functions have the following declarations:

frac32 t MLIB Mac4Sat F32ssss(fracl6 t fl6AddiMultl, fracl6 t f1l16AddlMult2, fracl6 t fl6Add2Multl,
fracleé t fl6Add2Mult2)
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2.20.3 Function use

The use of the MLIB_Mac4Sat function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result;
static fraclé t fl16AddiMultl, f16AddlMult2, fl6Add2Multl, f1l6Add2Mult2;

void main (void)

{

f16Add1Multl = FRAC16(-1.0); /* £16Add1Multl = -1.0 */
f16Add1lMult2 = FRAC16(-0.9); /* f16Add1Mult2 = -0.9 */
f16Add2Multl = FRAC16(0.8); /* fl16Add2Multl = 0.8 */
fl16Add2Mult2 = FRAC16(0.7); /* f16Add2Mult2 = 0.7 */

/* f£32Result = sat(f16AddiMultl * f1l6AddIlMult2 + fl6Add2Multl * fl6Add2Mult2) */
f32Result = MLIB Mac4Sat F32ssss(fl16AddlMultl, fl6AddlMult2, fl6Add2Multl,
fl6Add2Mult?2) ;
}

2.21 MLIB_Mac4Rnd

The MLIB_Mac4Rnd functions return the rounded sum of two products of two pairs of multiplicands. The round method is the round
to nearest. The function does not saturate the output. See the following equation:

MLIB Mac4Rnd(a, b,¢c,d) =round(a*b+ced)
Figure 41. Algorithm formula

2.21.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_Mac4Rnd function are shown in the following table.

Table 22. Function versions

Function name Input type Result Description
Product 1 Product 2 type
Mult. 1 Mult. 2 | Mult. 1 Mult. 2

MLIB_Mac4Rnd_F16 |frac16_t |frac16_t |frac16_t |frac16_t |frac16_t | Addition of two 16-bit fractional products (of
two 16-bit fractional multiplicands), rounded
to the upper 16 bits. The output is within the
range <-1; 1).

MLIB_Mac4Rnd_F32 |frac32_t |frac32_t |frac32_t |frac32_t |frac32_t | Addition of two 32-bit fractional products (of
two 32-bit fractional multiplicands), rounded
to the upper 32 bits. The output is within the
range <-1; 1).
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2.21.2 Declaration

The available MLIB_Mac4Rnd functions have the following declarations:

fraclé_t MLIB Mac4Rnd F16(fracl6 t fl16AddiMultl, fraclé t fl6AddlMult2, fraclé6 t fl6Add2Multl,
fracle t fl16Add2Mult2)

frac32 t MLIB Mac4Rnd F32(frac32 t f32AddlMultl, frac32 t f32AddlMult2, frac32 t f32Add2Multl,
frac32 t £32Add2Mult2)

2.21.3 Function use

The use of the MLIB_Mac4Rnd function is shown in the following example:

#include "mlib.h"

static fracl6 t fl6Result, fl16AddiMultl, f16AddIiMult2, f16Add2Multl, fl6Add2Mult2;

void main (void)

{

f16Add1Multl = FRAC16(0.256) ; /* f16AddlMultl = 0.256 */
f16Add1Mult2 = FRAC16(-0.724); /* £16AddlMult2 = -0.724 */
f16Add2Multl = FRAC16(0.365); /* £16Add2Multl = 0.365 */
f16Add2Mult2 = FRAC16(-0.25); /* fl16Add2Mult2 = -0.25 */

/* fl6Result = round(fl16AddlMultl * f16AddlMult2 + £16Add2Multl * fl6Add2Mult2) */
fl6Result = MLIB Mac4Rnd F16(f16Add1Multl, f16AddlMult2, fl6Add2Multl,
fl16Add2Mult2) ;
}

2.22 MLIB_Mac4RndSat

The MLIB_Mac4RndSat functions return the rounded sum of two products of two pairs of multiplicands. The round method is the
round to nearest. The function saturates the output. See the following equation:

1, round(a*b+ced)>1
MLIB_Mac4RndSat(a, b, c,d) = -1 round(a*b+ced) <-1
round(a*b+ced), else

Figure 42. Algorithm formula

2.22.1 Available versions
The function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_Mac4RndSat function are shown in the following table.
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Table 23. Function versions

Function name Input type Result Description
Product 1 Product 2 type
Mult. 1 Mult. 2 | Mult. 1 Mult. 2

MLIB_Mac4RndSat_F16 frac16_t |frac16_t |frac16_t |frac16_t |frac16_t | Addition of two 16-bit fractional products
(of two 16-bit fractional multiplicands),
rounded to the upper 16 bits. The outputis
within the range <-1; 1).

MLIB_Mac4RndSat_F32 frac32_t |frac32_t |frac32_t |frac32_t |frac32_t | Addition of two 32-bit fractional products
(of two 32-bit fractional multiplicands),
rounded to the upper 32 bits. The outputis
within the range <-1; 1).

2.22.2 Declaration

The available MLIB_Mac4RndSat functions have the following declarations:

fracl6 t MLIB Mac4RndSat F16(fraclé t fl6AddlMultl, fracl6 t f16AddIiMult2, fraclée t fl6Add2Multl,
fracle t fl16Add2Mult2)

frac32 t MLIB Mac4RndSat F32(frac32 t f32AddlMultl, frac32 t f32Addl1Mult2, frac32 t f32Add2Multl,
frac32_t f£32Add2Mult2)

2.22.3 Function use

The use of the MLIB_Mac4RndSat function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result, £32Add1Multl, f32AddiMult2, £32Add2Multl, £f32Add2Mult2;

void main (void)

{

f32Add1Multl = FRAC32(-1.0); /* £32Add1Multl = -1.0 */
£32AddIMult2 = FRAC32(-0.9); /* £32Add1Mult2 = -0.9 */
£32Add2Multl = FRAC32(0.8); /* £32Add2Multl = 0.8 */
£32Add2Mult2 = FRAC32(0.7); /* £32Add2Mult2 = 0.7 */

/* f£32Result = sat(round(£f32Add1Multl * £32Add1Mult2 + f32Add2Multl *
£f32Add2Mult2)) */

f32Result = MLIB Mac4RndSat F32(f32Add1Multl, f32AddlMult2, f32Add2Multl,
£32Add2Mult?2) ;
}
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2.23 MLIB_Mnac

The MLIB_Mnac functions return the product of two multiplicands minus the input accumulator. The function does not saturate the
output. See the following equation:

MLIB Mnac(a, b,c) =bsc—a
Figure 43. Algorithm formula

2.23.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1 ; 1).
The accumulator is the accumulator type, the multiplicands are the fractional types. The result may overflow.

The available versions of the MLIB_Mnac function are shown in the following table.

Table 24. Function versions

Function name Input type Result Description

type

Accum. Mult. 1 Mult. 2

MLIB_Mnac_F16 frac16_t |frac16_t |frac16_t |frac16_t | The 16-bit fractional accumulator is subtracted from the
upper 16-bit portion [16..31] of the fractional product (of
two 16-bit fractional multiplicands). The output is within the
range <-1; 1).

MLIB_Mnac_F32Iss frac32_t |frac16_t |frac16_t |frac32_t | The 32-bit fractional accumulator is subtracted from
the 32-bit fractional product (of two 16-bit fractional
multiplicands). The output is within the range <-1; 1).

MLIB_Mnac_F32 frac32_t |frac32_t |frac32_t |frac32_t | The 32-bit fractional accumulator is subtracted from the
upper 32-bit portion [32..63] of the fractional product (of
two 32-bit fractional multiplicands). The output is within the
range <-1; 1).

MLIB_Mnac_A32ass |acc32_t |frac16_t |frac16_t |acc32_t | The 32-bit accumulator is subtracted from the upper 16-bit
portion [16..31] of the fractional product (of two 16-bit
fractional multiplicands). The output may be out of the
range <-65536 ; 65536).

2.23.2 Declaration

The available MLIB_Mnac functions have the following declarations:

fraclé t MLIB Mnac F16(fracl6 t fl6Accum, fracl6 t fle6Multl, fracl6 t fl6Mult2)
frac32_t MLIB Mnac F32lss(frac32_t f32Accum, fracl6_t fleMultl, fracle t fleMult2)
frac32 t MLIB Mnac F32(frac32 t f32Accum, frac32 t £32Multl, frac32 t f32Mult2)
acc32_t MLIB Mnac A32ass(acc32 t a32Accum, fracl6 t fle6Multl, fraclé6 t fleMult2)

2.23.3 Function use

The use of the MLIB_Mnac function is shown in the following examples:
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Fixed-point version:
#include "mlib.h"

static frac32 t f32Accum, f32Result;
static fracl6 t fl6Multl, fle6Mult2;

void main (void)

{

£f32Accum = FRAC32(0.3); /* £32Accum = 0.3 */
fl6Multl = FRAC16(0.1); /* floMultl = 0.1 */
floMult2 = FRAC16(-0.2); /* fleMult2 = -0.2 */

/* £32Result = flé6Multl * fl6Mult2 - £32Accum */
f32Result = MLIB Mnac F321ss (f32Accum, flé6Multl, fléMult2);

2.24 MLIB_MnacSat

The MLIB_MnacSat functions return the product of two multiplicands minus the input accumulator. The function saturates the
output. See the following equation:

1, bec—a>1
MLIB_MnacSat(a,b,¢) ={ 1, bec—a<-1
bec—a, else

Figure 44. Algorithm formula

2.24.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The result
may saturate.

The available versions of the MLIB_MnacSat function are shown in the following table.

Table 25. Function versions

Function name Input type Result Description

Accum. | Muit1 | mut2 | YP°

MLIB_MnacSat_F16 |frac16_t |frac16_t |frac16_t |frac16_t | The 16-bit fractional accumulator is subtracted from the
upper 16-bit portion [16..31] of the fractional product (of
two 16-bit fractional multiplicands). The output is within the
range <-1; 1).

MLIB_MnacSat_F32Is | frac32_t |frac16_t |frac16_t |frac32_t | The 32-bit fractional accumulator is subtracted from
s the 32-bit fractional product (of two 16-bit fractional
multiplicands). The output is within the range <-1; 1).

MLIB_MnacSat_F32 |frac32_t |frac32_t |frac32_t |frac32_t | The 32-bit fractional accumulator is subtracted from the
upper 32-bit portion [32..63] of the fractional product (of
two 32-bit fractional multiplicands). The output is within the
range <-1; 1).
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2.24.2 Declaration
The available MLIB_MnacSat functions have the following declarations:
fraclé_t MLIB MnacSat F16(fracl6 t fl6Accum, fracl6 t fl6Multl, fracl6 t fl6Mult2)

frac32 t MLIB MnacSat F321ss(frac32 t f32Accum, fraclé t flé6Multl, fraclé t flé6Mult2)
frac32 t MLIB MnacSat F32(frac32 t f32Accum, frac32 t f32Multl, frac32 t f32Mult2)

2.24.3 Function use

The use of the MLIB_MnacSat function is shown in the following example:

#include "mlib.h"

static frac32 t f£32Accum, f32Result;
static fraclé6 t fle6Multl, fleMult2;

void main (void)

{
f32Accum = FRAC32(0.3); /* £32Accum = 0.3 */
fleMultl = FRAC1l6(0.1); /* fleMultl 0.1 */
fléeMult2 = FRAC16(-0.2); /* fleMult2 =0.2 =/

)
)

/* £32Result = fl6Multl * fl6Mult2 - f32Accum */
f32Result = MLIB MnacSat F321ss(f32Accum, fl6Multl, fl6Mult2);

2.25 MLIB_MnacRnd

The MLIB_MnacRnd functions return the rounded product of two multiplicands minus the input accumulator. The round method
is the round to nearest. The function does not saturate the output. See the following equation:

MLIB MnacRnd(a, b,c) =round(bec) —a

Figure 45. Algorithm formula

2.25.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1 ; 1).
The accumulator is the accumulator type, the multiplicands are the fractional types. The result may overflow.

The available versions of the MLIB_MnacRnd function are shown in the following table.

Table 26. Function versions

Function name Input type Result Description

Accum. | Muit.1 | mut2 | YP®

MLIB_MnacRnd_F16 frac16_t |frac16_t |frac16_t |frac16_t | The 16-bit fractional accumulator is subtracted
from the fractional product (of two 16-bit fractional

Table continues on the next page...
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Function name

Input type

Result

Accum.

Mult. 1

Mult. 2

type

Description

multiplicands) rounded to the upper 16 bits. The
output is within the range <-1 ; 1).

MLIB_MnacRnd_F32lls

frac32_t

frac32_t

frac16_t

frac32_t

The 32-bit fractional accumulator is subtracted
from the fractional product (of a 32-bit and a 16-bit
fractional multiplicand) rounded to the upper 32
bits [16..48]. The output is within the range <-1; 1).

MLIB_MnacRnd_F32

frac32_t

frac32_t

frac32_t

frac32_t

The 32-bit fractional accumulator is subtracted
from the fractional product (of two 32-bit fractional
multiplicands) rounded to the upper 32 bits
[32..63]. The output is within the range <-1 ; 1).

MLIB_MnacRnd_A32ass

acc32_t

frac16_t

frac16_t

acc32_t

The 32-bit accumulator is subtracted from
the fractional product (of two 16-bit fractional
multiplicands) rounded to the upper 16-bits
[16..31]. The output may be out of the range
<-65536 ; 65536).

2.25.2 Declaration

The available MLIB_MnacRnd functions have the following declarations:

fraclé_t MLIB MnacRnd F16(fracl6 t fl6Accum,
frac32 t MLIB MnacRnd F3211s(frac32_ t f32Accum,
frac32_t MLIB MnacRnd F32 (frac32_t f32Accum,
acc32 t MLIB MnacRnd A32ass (acc32 t a32Accum,

2.25.3 Function use

fracle t fleMultl, fraclé t fleMult2)

frac32 t £32Multl, fraclé t fleMult2)

frac32 t £32Multl, frac32 t £32Mult2)

The use of the MLIB_MnacRnd function is shown in the following example:

fraclé t fleMultl, fracl6 t fleMult2)

{
f32Accum
£32Multl
fleMult2 =

#include "mlib.h"

static frac32 t f£32Accum,
static fracl6_t fl6Mult2;

void main (void)

FRAC32(0.3) ;
FRAC32(0.4);

FRAC16(-0.2) ;

f32Result,

£32Mul

/*
/*
/*

/* f32Result = round(f32Multl * fle6Mult2
f32Result =

MLIB MnacRnd F3211s (f32Accum,

tl;

£32Accum
£32Multl
fleMult2

- f£32Accum)

£32Multl

’

0.3 =/
0.4 */
=0.2 */

=)
fleMult2) ;
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2.26 MLIB_MnacRndSat

The MLIB_MnacRndSat functions return the rounded product of two multiplicands minus the input accumulator. The round method
is the round to nearest. The function saturates the output. See the following equation:

L round(bec) —a>1
MLIB MnacRndSat(a, b, c) = -1, round(bec) —a<-1
round(bec) —a, else

Figure 46. Algorithm formula

2.26.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_MnacRndSat function are shown in the following table.

Table 27. Function versions

Function name Input type Result Description
type

Accum. Mult. 1 Mult. 2

MLIB_MnacRndSat_F16 frac16_t |[frac16_t |frac16_t |frac16_t | The 16-bit fractional accumulator is subtracted
from the fractional product (of two 16-bit
fractional multiplicands) rounded to the upper
16 bits. The output is within the range <-1 ; 1).

MLIB_MnacRndSat_F32Ils frac32_t |frac32_t |frac16_t |frac32_t | The 32-bit fractional accumulator is subtracted
from the fractional product (of a 32-bit and a
16-bit fractional multiplicand) rounded to the
upper 32 bits [16..48]. The output is within the
range <-1; 1).

MLIB_MnacRndSat_F32 frac32_t |frac32_t |frac32_t |frac32_t | The 32-bit fractional accumulator is subtracted
from the fractional product (of two 32-bit
fractional multiplicands) rounded to the upper
32 bits [32..63]. The output is within the range
<-1;1).

2.26.2 Declaration

The available MLIB_MnacRndSat functions have the following declarations:

fraclé t MLIB MnacRnd F16(fracl6 t fl6Accum, fracl6 t fl6Multl, fracl6 t fl6Mult2)
frac32 t MLIB MnacRnd F3211ls(frac32 t f£32Accum, frac32 t £32Multl, fraclé6 t flé6Mult2)
frac32 t MLIB MnacRnd F32(frac32 t f32Accum, frac32 t f32Multl, frac32 t f32Mult2)

2.26.3 Function use

The use of the MLIB_MnacRndSat function is shown in the following example:

#include "mlib.h"

static frac32 t f£32Accum, f32Result, £32Multl;
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static fraclé t flé6Mult2;

void main (void)

{
£32Accum = FRAC32(0.3); /* £32Accum = 0.3 */
£32Multl FRAC32 (0.4) ; /* £32Multl 0.4 */
fleMult2 = FRAC1l6(-0.2); /* fleMult2 -0.2 */

)
)

/* f£32Result = round(f32Multl * fl6Mult2 - f£32Accum) */
f32Result = MLIB MnacRndSat F3211s (f32Accum, f£32Multl, fleéeMult2);

2.27 MLIB_Msu

The MLIB_Msu functions return the fractional product of two multiplicands subtracted from the input accumulator. The function
does not saturate the output. See the following equation:

MLIB Msu(a, b,c)=a—bec
Figure 47. Algorithm formula

2.27.1 Available versions
This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1; 1).
The accumulator is the accumulator type, the multiplicands are the fractional types. The result may overflow.

The available versions of the MLIB_Msu function are shown in the following table.

Table 28. Function versions

Function name Input type Result Description

Accum. | Muit1 | mut2 | YP°

MLIB_Msu_F16 frac16_t |frac16_t |frac16_t |frac16_t | The upper 16-bit portion [16..31] of the fractional product
(of two 16-bit fractional multiplicands) is subtracted from
a 16-bit fractional accumulator. The output is within the
range <-1; 1).

MLIB_Msu_F32Iss frac32_t |frac16_t |frac16_t |frac32_t | The 32-bit fractional product (of two 16-bit fractional
multiplicands) is subracted from a 32-bit fractional
accumulator. The output is within the range <-1 ; 1).

MLIB_Msu_F32 frac32_t |frac32_t |frac32_t |frac32_t | The upper 32-bit portion [32..63] of the fractional product
(of two 32-bit fractional multiplicands) is subtracted from
a 32-bit fractional accumulator. The output is within the
range <-1; 1).

MLIB_Msu_A32ass acc32_t |[frac16_t |frac16_t |acc32_t | The upper 16-bit portion [16..31] of the fractional product
(of two 16-bit fractional multiplicands) is subtracted from
a 32-bit accumulator. The output may be out of the range
<-65536 ; 65536).

MLIB User's Guide, Rev. 5, 01 November 2021
User Guide 55/110




NXP Semiconductors

Algorithms in detail

2.27.2 Declaration

The available MLIB_Msu functions have the following declarations:

fraclé t MLIB Msu Fl6(fracl6e t fl6Accum, fraclée t fleMultl, fracle t fleMult2)
frac32 t MLIB Msu F321lss(frac32 t f32Accum, fraclé t fléMultl, fraclé t fleéeMult2)
frac32 t MLIB Msu F32(frac32 t f32Accum, frac32 t f£32Multl, frac32 t f32Mult2)
acc32 t MLIB Msu A32ass(acc32 t a32Accum, fracl6 t fleMultl, fracl6 t fleMult2)

2.27.3 Function use

The use of the MLIB_Msu function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static acc32 t a32Accum, a32Result;
static fraclé t fl6Multl, fl6Mult2;

void main (void)

{

a32Accum = ACC32(2.3); /* a32Accum = 2.3 */
fléMultl = FRAC16(0.1); /* fleMultl = 0.1 */
fl6Mult2 = FRAC16(-0.2); /* floMult2 = -0.2 */

/* a32Result = a32Accum - fl6Multl * fle6Mult2 */
a32Result = MLIB Msu A32ass (a32Accum, fleMultl, fleMult2);

2.28 MLIB_MsuSat

The MLIB_MsuSat functions return the fractional product of two multiplicands subtracted from the input accumulator. The function
saturates the output. See the following equation:

L a—bec>1
MLIB MsuSat(a, b, c) = -1, a—bec<-1
a—bec, else

Figure 48. Algorithm formula

2.28.1 Available versions
This function is available in the following versions:

+ Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_MsuSat function are shown in the following table.
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Table 29. Function versions

Function name Input type Result Description

type

Accum. Mult. 1 Mult. 2

MLIB_MsuSat_F16 frac16_t |frac16_t |frac16_t |frac16_t | The upper 16-bit portion [16..31] of the fractional
product (of two 16-bit fractional multiplicands) is
subtracted from a 16-bit fractional accumulator. The
output is within the range <-1; 1).

MLIB_MsuSat_F32Iss frac32_t |frac16_t |frac16_t |frac32_t | The 32-bit fractional product (of two 16-bit fractional
multiplicands) is subtracted from a 32-bit fractional
accumulator. The output is within the range <-1; 1).

MLIB_MsuSat_F32 frac32_t |frac32_t |frac32_t |frac32_t |The upper 32-bit portion [32..63] of the fractional
product (of two 32-bit fractional multiplicands) is
subracted from a 32-bit fractional accumulator. The
output is within the range <-1; 1).

2.28.2 Declaration

The available MLIB_MsuSat functions have the following declarations:

fraclé_t MLIB MsuSat Fl6(fraclé6 t fl6Accum, fraclé t fléeMultl, fraclé t fleMult2)
frac32 t MLIB MsuSat F321ss(frac32 t f32Accum, fraclé t fleMultl, fraclé t fl6Mult2)
frac32 t MLIB MsuSat F32(frac32 t f32Accum, frac32 t £32Multl, frac32 t £32Mult2)

2.28.3 Function use

The use of the MLIB_MsuSat function is shown in the following example:

#include "mlib.h"
static frac32 t f32Accum, f£32Multl, £32Mult2, £32Result;

void main (void)

{
f32Accum = FRAC32(0.9)
f£32Multl FRAC32 (-1.
£32Mult2 = FRAC32(0.2)

2 /* £32Accum = 0.9 */
); /* £32Multl =1.,0 =/
g /* £32Mult2 0.2 */

/* £32Result = sat (f32Accum - £32Multl * £32Mult2) */
f32Result = MLIB MsuSat F32 (f32Accum, f32Multl, £32Mult2);

2.29 MLIB_MsuRnd

The MLIB_MsuRnd functions return the rounded fractional product of two multiplicands subtracted from the input accumulator.
The round method is the round to nearest. The function does not saturate the output. See the following equation:

MLIB MsuRnd(a, b, ¢) =a—round(bec)
Figure 49. Algorithm formula
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» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1 ; 1).
The accumulator is the accumulator type, the multiplicands are the fractional types. The result may overflow.

The available versions of the MLIB_MsuRnd function are shown in the following table.

Table 30. Function versions

Function name Input type Result Description
Accum. | Mut 1 | Mut2 | OP®

MLIB_MsuRnd_F16 frac16_t |frac16_t |frac16_t |frac16_t | The fractional product (of two 16-bit fractional
multiplicands), rounded to the upper 16 bits, is
subtracted from a 16-bit fractional accumulator. The
output is within the range <-1; 1).

MLIB_MsuRnd_F32Ils frac32_t |frac32_t |frac16_t |frac32_t | The fractional product (of a 32-bit and 16-bit fractional
multiplicands), rounded to the upper 32 bits [16..48],
is subtracted from a 32-bit fractional accumulator. The
output is within the range <-1; 1).

MLIB_MsuRnd_F32 frac32_t |frac32_t |frac32_t |frac32_t | The fractional product (of two 32-bit fractional
multiplicands), rounded to the upper 32 bits [32..63],
is subtracted from a 32-bit fractional accumulator. The
output is within the range <-1; 1).

MLIB_MsuRnd_A32ass acc32_t |[frac16_t |frac16_t |acc32_t | The fractional product (of two 16-bit fractional
multiplicands), rounded to the upper 16 bits [16..31], is
subtracted from a 32-bit accumulator. The output may
be out of the range <-65536 ; 65536).

2.29.2 Declaration

The available MLIB_MsuRnd functions have the following declarations:

fracl6e t MLIB MsuRnd F16(fracl6 t fl6Accum,
frac32_t MLIB_MsuRnd F3211s(frac32_t f32Accum,
frac32_t MLIB_MsuRnd_F32(frac32_t f32Accum,
acc32 t MLIB MsuRnd A32ass(acc32_ t a32Accum,

2.29.3 Function use

fraclé t fleMultl, fraclé t fleMult2)
frac32 t £32Multl, fraclé6 t fleMult2)
frac32 t £32Multl, frac32 t £32Mult2)
fracle t fleMultl, fraclée t fleMult2)

The use of the MLIB_MsuRnd function is shown in the following example:

{
fl6Accum =
fleMultl =
fleMult2 =

#include "mlib.h"

static fracl6_t fl6Accum,

void main (void)

FRAC16(0.3);
FRAC16(0.1) ;
FRAC16 (-0.2) ;

fleMultl,

fleMult2,

/* fl6Accum
/* fl6Multl
/* £1l6Mult2

fl6Result;

=0.3 */
Qo1 */
-0.2 */
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/* fl6Result = round(fl6Accum - fle6Multl * fleMult2) */
fl6Result = MLIB MsuRnd F16(fl6Accum, fl6Multl, fl6Mult2);

2.30 MLIB_MsuRndSat

The MLIB_MsuRndSat functions return the rounded fractional product of two multiplicands subtracted from the input accumulator.
The round method is the round to nearest. The function saturates the output. See the following equation:

L a—round(bec)>1
MLIB_MsuRndSat(a, b, ¢) = -1, a—round(bec) <-1
a—round(bec), else

Figure 50. Algorithm formula

2.30.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The result
may saturate.

The available versions of the MLIB_MsuRndSat function are shown in the following table.

Table 31. Function versions

Function name Input type Result Description

Accum. | Mult.1 | mut2 | YPe

MLIB_MsuRndSat_F16 frac16_t |frac16_t |frac16_t |frac16_t | The fractional product (of two 16-bit fractional
multiplicands), rounded to the upper 16 bits, is
subtracted from a 16-bit fractional accumulator.
The output is within the range <-1; 1).

MLIB_MsuRndSat_F32lls frac32_t |frac32_t |frac16_t |frac32_t | The fractional product (of a 32-bit and 16-bit
fractional multiplicands), rounded to the upper 32
bits [16..48], is subtracted from a 32-bit fractional
accumulator. The outputis within the range <-1; 1).

MLIB_MsuRndSat_F32 frac32_t |frac32_t |frac32_t |frac32_t | The fractional product (of two 32-bit fractional
multiplicands), rounded to the upper 32 bits
[32..63], is subtracted from a 32-bit fractional
accumulator. The outputis within the range <-1; 1).

2.30.2 Declaration

The available MLIB_MsuRndSat functions have the following declarations:

fraclé t MLIB MsuRndSat F16(fracl6 t fl6Accum, fracl6 t fle6Multl, fraclé6 t fleMult2)
frac32 t MLIB MsuRndSat F3211ls(frac32 t f32Accum, frac32 t f32Multl, fraclé t fléeMult2)
frac32 t MLIB MsuRndSat F32(frac32 t f32Accum, frac32 t £32Multl, frac32 t £32Mult2)
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#include "mlib.h"

void main (void)
{
f32Accum = FRAC32(0.3); /* f£32Accum
f32Multl = FRAC32(0.1); /* £32Multl
£32Mult2 FRAC32 (-0.2) ; /* £32Mult2

)
)

static frac32 t f32Accum, f32Multl, £32Mult2, f32Result;

.3 */
@.1 */
=0.2 =/

/* f32Result = sat(round(f32Accum - £32Multl * f£32Mult2)) */

f32Result = MLIB MsuRndSat F32 (£32Accum, f£32Multl, £32Mult2);

2.31 MLIB_Msu4

The MLIB_Msu4 functions return the subtraction of the products of two multiplicands. The function does not saturate the output.

See the following equation:

MLIB Msu4(a,b,c,d)=asb—ced

Figure 51. Algorithm formula

2.31.1 Available versions

The function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_Msu4 function are shown in the following table.

Table 32. Function versions

Function name Input type Result Description
Minuend product Subtrahend product type
Mult. 1 Mult. 2 Mult. 1 Mult. 2
MLIB_Msu4_F32ssss frac16_t |frac16_t |[frac16_t frac16_t frac32_t | Subtraction of two 32-bit fractional

products (of two 16-bit fractional
multiplicands). The output is within the
range <-1; 1).

2.31.2 Declaration

The available MLIB_Msu4 functions have the following declarations:

frac32 t MLIB Msu4 F32ssss(fracl6 t fl6MinMultl, fraclé t flé6MinMult2,

fracle t flé6SubMult2)
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2.31.3 Function use

The use of the MLIB_Msu4 function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static fracl6 t fl6MinMultl, fl6MinMult2, f1l6SubMultl, fl6SubMult2;

void main (void)

{

fl6MinMultl = FRAC16(0.2); /* fl6MinMultl = 0.2 */
f16MinMult2 = FRAC16(-0.7); /* fl6MinMult2 = -0.7 */
fl6SubMultl = FRAC16(0.3); /* fl6SubMultl = 0.3 */
fl6SubMult2 = FRAC1l6(-0.25); /* f16SubMult2 = -0.25 */

/* £32Result = flé6MinMultl * flé6MinMult2 - f£16SubMultl * fl6SubMult2 */
f32Result = MLIB Msu4 F32ssss(fl6MinMultl, fl6MinMult2, fl16SubMultl, fl6SubMult2);

2.32 MLIB_Msu4Sat

The MLIB_Msu4Sat functions return the subtraction of the products of two multiplicands. The function saturates the output. See
the following equation:

L asb—ced>1
MLIB MsudSat(a, b,c,d) = -1, a*b—ced<-1
a*b—ced, else

Figure 52. Algorithm formula

2.32.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_Msu4Sat function are shown in the following table.

Table 33. Function versions

Function name Input type Result Description
type

Minuend product Subtrahend product
Mult. 1 Mult. 2 Mult. 1 Mult. 2

MLIB_Msu4Sat_F32ssss frac16_t |frac16_t frac16_t frac16_t frac32_t | Subtraction of two 32-bit fractional
products (of two 16-bit fractional

Table continues on the next page...
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Table 33. Function versions

Function name Input type Result Description
type
Minuend product Subtrahend product yp
Mult. 1 Mult. 2 Mult. 1 Mult. 2

multiplicands). The output is within
the range <-1; 1).

2.32.2 Declaration

The available MLIB_Msu4Sat functions have the following declarations:

frac32 t MLIB Msu4Sat F32ssss(fracl6 t flé6MinMultl, fracl6 t fl6MinMult2, fracl6 t fl6SubMultl,
fraclé t fl6SubMult2)

2.32.3 Function use

The use of the MLIB_Msu4Sat function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result;
static fraclé6 t fl16MinMultl, f16MinMult2, f16SubMultl, fl6SubMult2;

void main (void)

{

f16MinMultl = FRAC16(0.8); /* fl6MinMultl = 0.8 */
fl6MinMult2 = FRAC16(-0.9); /* fléMinMult2 = -0.9 */
fl6SubMultl = FRAC16(0.7); /* fl6SubMultl = 0.7 */
f16SubMult2 = FRAC16(0.9); /* f£l6SubMult2 = 0.9 */

/* f32Result = sat(flé6MinMultl * fl16MinMult2 - fl6SubMultl * fl6SubMult2) */
f32Result = MLIB Msu4Sat F32ssss(fl6MinMultl, fl6MinMult2, fl6SubMultl,
fle6SubMult2) ;
}

2.33 MLIB_Msu4Rnd

The MLIB_Msu4Rnd functions return the rounded subtraction of two products of two pairs of multiplicands. The round method is
the round to nearest. The function does not saturate the output. See the following equation:

MLIB Msu4Rnd(a, b, c,d) =round(a*b—c+d)
Figure 53. Algorithm formula

2.33.1 Auvailable versions

This function is available in the following versions:
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» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_Msu4Rnd function are shown in the following table.

Table 34. Function versions

Function name Input type Result Description
e
Minuend product Subtrahend product typ
Mult. 1 Mult. 2 Mult. 1 Mult. 2

MLIB_Msu4Rnd_F16 |frac16_t |frac16_t frac16_t frac16_t frac16_t | Subtraction of two 16-bit fractional
products (of two 16-bit fractional
multiplicands), rounded to the upper
16 bits. The output is within the range
<-1;1).

MLIB_Msu4Rnd_F32 |frac32_t |frac32_t frac32_t frac32_t frac32_t | Subtraction of two 32-bit fractional
products (of two 32-bit fractional
multiplicands), rounded to the upper
32 bits. The output is within the range
<-1;1).

2.33.2 Declaration

The available MLIB_Msu4Rnd functions have the following declarations:

fracl6 t MLIB Msud4Rnd F16(fracl6 t fl6MinMultl,

fracle_t fl6SubMult2)

frac32 t MLIB Msu4Rnd F32(frac32 t f£32MinMultl,

frac32 t £32SubMult2)

2.33.3 Function use

fraclé t fléMinMult2,

frac32 t f£32MinMult2,

The use of the MLIB_Msu4Rnd function is shown in the following example:

fracle_t flé6SubMultl,

frac32 t £32SubMultl,

#include "mlib.h"

static fraclé t f

void main (void)
{
fléeMinMultl =
fleMinMult2 =
fl6SubMultl =
fl6SubMult2 =

/* f£32Result =
fl6Result =

16Result,

FRAC16(0.256) ;

FRAC16 (-0.72

FRAC16(0.365) ;
(

FRAC16 (-0.25) ;

fl6MinMult2, fl6SubMultl, fl6SubMult2;
/* fléMinMultl = 0.256 */
/* fleMinMult2 = -0.724%*/
/* £16SubMultl = 0.365 */
/* f£16SubMult2 = -0.25 */
round (f16MinMultl * flé6MinMult2 - f16SubMultl * fl6SubMult2) */
fléMinMult2, fleéeSubMultl, fle6SubMult2);

4);

fl6MinMultl,

MLIB Msu4Rnd F16 (f16MinMultl,
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2.34 MLIB_Msu4RndSat

The MLIB_Msu4RndSat functions return the rounded subtraction of two products of two pairs of multiplicands. The round method

is the round to nearest. The function saturates the output. See the following equation:

1 round(a*b—c+d) >1
MLIB Msu4RndSat(a, b, c,d) = -1, round(a*b—ced) <-1
round(a*b—ced), else

Figure 54. Algorithm formula

2.34.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_Msu4RndSat function are shown in the following table.

Table 35. Function versions

Function name Input type Result Description
Minuend product Subtrahend product type
Mult. 1 Mult. 2 Mult. 1 Mult. 2

range <-1; 1).

MLIB_Msu4RndSat_F16 frac16_t |frac16_t |frac16_t frac16_t frac16_t | Subtraction of two 16-bit fractional
products (of two 16-bit fractional
multiplicands), rounded to the upper
16 bits. The output is within the

range <-1; 1).

MLIB_Msu4RndSat_F32 frac32_t |frac32_t |frac32_t frac32_t frac32_t | Subtraction of two 32-bit fractional
products (of two 32-bit fractional
multiplicands), rounded to the upper
32 bits. The output is within the

2.34.2 Declaration

The available MLIB_Msu4RndSat functions have the following declarations:

fracl6é t MLIB Msu4RndSat F16(fracl6 t fl6MinMultl, fraclé6 t fléMinMult2, fracl6é t fl6SubMultl,
fracle t flé6SubMult2)

frac32_t MLIB Msud4RndSat F32(frac32_ t f32MinMultl, frac32 t f32MinMult2, frac32 t f32SubMultl,
frac32_t £32SubMult2)
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2.34.3 Function use

The use of the MLIB_Msu4RndSat function is shown in the following example:

#include "mlib.h"
static fracl6 t fl6Result, fléMinMultl, fléMinMult2, fl6SubMultl, fl6SubMult2;

void main (void)

{

fl6MinMultl = FRAC16(0.8); /* fl6MinMultl = 0.8 */
fl6MinMult2 = FRAC16(-0.9); /* fleMinMult2 = -0.9 */
fl6SubMultl = FRAC16(0.7); /* fl6SubMultl = 0.7 */
£f16SubMult2 = FRAC16(0.9); /* £l16SubMult2 = 0.9 */

/* fl6Result = sat(round(fl6MinMultl * fl6MinMult2 - fl6SubMultl * fl6SubMult2)) */
fl6Result = MLIB Msu4RndSat F16(fl6MinMultl, flé6MinMult2, fl6SubMultl,
fl6SubMult2) ;
}

2.35 MLIB_Mul

The MLIB_Mul functions return the product of two multiplicands. The function does not saturate the output. See the
following equation:

MLIB Mul(a, b)=a*b
Figure 55. Algorithm formula

2.35.1 Available versions
This function is available in the following versions:

» Fractional output with fractional inputs - the output is the fractional portion of the result; the result is within the range <-1 ; 1).
The inputs are the fractional values only. The result may overflow.

 Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may overflow.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_Mul function are shown in the following table:

Table 36. Function versions

Function name Input type Result Description

Mut.1 | mut2 | YP°

MLIB_Mul_F16 frac16_t |frac16_t |[frac16_t | Product of two 16-bitfractional multiplicands; the output are the upper 16
bits of the results [16..31]. The output is within the range <-1; 1).

MLIB_Mul_F16as acc32_t |frac16_t |frac16_t |Product of a 32-bit accumulator and a 16-bit fractional multiplicand; the
output is a 16-bit fractional portion, which has the upper 16 bits of the
fractional value of the result [16..31]. The output is within the range
<-1;1).

Table continues on the next page...
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Table 36. Function versions (continued)

Function name Input type Result Description

Mut.1 | mutz2 | YP®

MLIB_Mul_F32ss |frac16_t |frac16_t |frac32_t |Product of two 16-bit fractional multiplicands; the result is a 32-bit
fractional value. The output is within the range <-1; 1).

MLIB_Mul_F32 frac32_t |frac32_t |[frac32_t | Product of two 32-bit fractional multiplicands; the output are the upper 32
bits of the results [16..31]. The output is within the range <-1; 1).

MLIB_Mul_A32 acc32_t |acc32_t |acc32_t |Product of two 32-bit accumulator multiplicands; the output is a 32-bit
accumulator, which has the upper mid bits of the result [16..47]. The
output is within the range <-65536.0 ; 65536.0).

2.35.2 Declaration

The available MLIB_Mul functions have the following declarations:

fraclé _t MLIB Mul F16(fraclé t flé6Multl, fraclé6 t flé6Mult2)
fracl6_t MLIB Mul Flé6as(acc32_t a32Accum, fraclé6 t fleéeMult)
frac32 t MLIB Mul F32ss(fracl6 t fléeMultl, fracl6 t fléeMult2)
frac32_t MLIB Mul F32(frac32 t £32Multl, frac32 t f32Mult2)
acc32 t MLIB Mul A32(acc32 t a32Multl, acc32 t a32Multl)

2.35.3 Function use

The use of the MLIB_Mul function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static fracl6 t flé6Multl, fleMult2;

void main (void)
{
fleMultl
floMult2 = FRAC16(-0.2); /* £16Mult2

FRAC16(0.4) ; /* fleMultl = 0.4 */
-0.2 */

/* £32Result = flé6Multl * fl6Mult2 */
f32Result = MLIB Mul F32ss(flé6Multl, fleMult2);

2.36 MLIB_MulSat

The MLIB_MulSat functions return the product of two multiplicands. The function saturates the output. See the following equation:

max, a*b>max
MLIB MulSat(a, b) = { min, a*b<min
asb, else

Figure 56. Algorithm formula
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» Fractional output with fractional inputs - the output is the fractional portion of the result; the result is within the range <-1 ; 1).
The inputs are the fractional values only. The result may saturate.

 Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may saturate.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1;1). The result

may overflow.

The available versions of the MLIB_MulSat function are shown in the following table:

Table 37. Function versions

Function name Input type Result Description
t
Mult. 1 | Mue2 | YP€

MLIB_MulSat_F16 frac16_t |frac16_t |frac16_t |Product of two 16-bit fractional multiplicands; the output is the upper
16 bits of the results [16..31]. The output is within the range <-1 ; 1).

MLIB_MulSat_F16as acc32_t |[frac16_t |frac16_t |Product of a 32-bit accumulator and a 16-bit fractional multiplicand;
the output is a 16-bit fractional value, which has the upper 16 bits of
the fractional portion of the result [16..31]. The output is within the
range <-1; 1).

MLIB_MulSat_F32ss frac16_t |frac16_t |frac32_t |Product of two 16-bit fractional multiplicands; the result is a 32-bit
fractional value. The output is within the range <-1; 1).

MLIB_MulSat_F32 frac32_t |frac32_t |frac32_t |Product of two 32-bit fractional multiplicands; the output are the
upper 32 bits of the results [16..31]. The output is within the range
<-1;1).

MLIB_MulSat_A32 acc32_t |acc32_t |acc32_t |Productoftwo 32-bitaccumulator multiplicands; the output is a 32-bit

accumulator, which has the mid bits of the result [16..47]. The output
is within the range <-65536.0 ; 65536.0).

2.36.2 Declaration

The available MLIB_MulSat functions have the following declarations:

fraclé t MLIB MulSat Fl16(fracl6e t fleMultl,

fraclé_t MLIB MulSat Fl6as(acc32 t a32Accum,
frac32 t MLIB MulSat F32ss(fracl6 t fleMultl,

frac32_t MLIB MulSat F32(frac32 t f32Multl,

fracle t fleMult2)
fracle t fleMult)
fracle t fleMult2)
frac32_t f£32Mult2)

acc32 t MLIB MulSat A32(acc32 t a32Multl, acc32 t a32Multl)

2.36.3 Function use

The use of the MLIB_MulSat function is shown in the following example:

#include

{

"mlib.h"

static acc32 t a32Accum;
static fracl6_t fleMult,

void main (void)

fl6Result;
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fl6Mult

fl6Result

a32Accum = ACC32(-5.5);

FRAC16(0.3);

/* fl6Result = sat(a32Accum * fle6Mult) */
MLIB MulSat Flé6as(a32Accum, fl6Mult);

Algorithms in detail

/* a32Accum = -5.5 */
/* fleMult = 0.3 */

2.37 MLIB_MulNeg

The MLIB_MulNeg functions return the negative product of two multiplicands. The function does not saturate the output. See the

following equation:

Figure 57. Algorithm formula

MLIB MulNeg(a,b) =—a<b

2.37.1 Available versions

This function is available in the following versions:

 Fractional output with fractional inputs - the output is the fractional portion of the result; the result is within the range <-1; 1).
The inputs are the fractional values only.

 Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may overflow.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1;1). The result

may overflow.

The available versions of the MLIB_MulNeg function are shown in the following table.

Table 38. Function versions

Function name

Input type

Result Description

Mult. 1 Mult. 2

type

MLIB_MuNegl_F16

frac16_t |frac16_t |frac16_t | Negative product of two 16-bit fractional multiplicands; the output

are the upper 16 bits of the results [16..31]. The output is within the
range <-1; 1).

MLIB_MulNeg_F16as

acc32_t |frac16_t |frac16_t | Negative product of a 32-bit accumulator and a 16-bit fractional

multiplicand; the output is a 16-bit fractional value, which has the
upper 16 bits of the fractional portion of the result [16..31]. The
output is within the range <-1; 1).

MLIB_MulNeg_F32ss

frac16_t |frac16_t |frac32_t | Negative product of two 16-bit fractional multiplicands; the result is

a 32-bit fractional value. The output is within the range <-1; 1).

MLIB_MulNeg_F32

frac32_t |frac32_t |frac32_t | Negative product of two 32-bit fractional multiplicands; the output

are the upper 32 bits of the results [16..31]. The output is within the
range <-1; 1).

MLIB_MulNeg_A32

acc32_t |acc32_t |acc32_t |Product of two 32-bit accumulator multiplicands; the output is a

32-bit accumulator, which has the mid bits of the result [16..47]. The
output is within the range <-65536.0 ; 65536.0).
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2.37.2 Declaration

The available MLIB_MulNeg functions have the following declarations:
fraclé t MLIB MulNeg Fl16(fracle t fleMultl, fracl6 t fleMult2)
fraclé_t MLIB MulNeg Flé6as(acc32 t a32Accum, fracl6 t fleéeMult)
frac32 t MLIB MulNeg F32ss(fracl6 t fleMultl, fracl6 t fleMult2)

frac32 t MLIB MulNeg F32(frac32 t £32Multl, frac32 t £32Mult2)
acc32 t MLIB MulNeg A32(acc32 t a32Multl, acc32 t a32Multl)

2.37.3 Function use

The use of the MLIB_MulNeg function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static frac32 t f32Result;
static fraclé6 t fl6Multl, fle6Mult2;

void main (void)
{
fleMultl
fleMult2 = FRAC16(-0.3); /* fleMult2

FRAC16(0.5) ; /* fl6Multl = 0.5 */
=0.3 =/

/* £32Result = flé6Multl * (-fl6Mult2) */
f32Result = MLIB MulNeg F32ss(fl6Multl, fleMult2);

2.38 MLIB_MulNegSat

The MLIB_MulNegSat functions return the negative product of two multiplicands. The function saturates the output. See the
following equation:

max, —a*b>max
MLIB MulNegSat(a, b) ={ min, —a*b<min
—asb, else

Figure 58. Algorithm formula

2.38.1 Available versions
This function is available in the following versions:

+ Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may saturate.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_MulNegSat function are shown in the following table:
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Table 39. Function versions

Function name Input type Result Description

Mut.1 | Mut2 | YPe

MLIB_MulNegSat_F16 |acc32_t |frac16_t |frac16_t |Negative product of a 32-bit accumulator and a 16-bit fractional

as multiplicand; the output is a 16-bit fractional value, which has the
upper 16 bits of the fractional portion of the result[16..31]. The output
is within the range <-1; 1).

MLIB_MulNegSat_A32 |acc32_t |acc32_t |acc32_t |Negative product of two 32-bit accumulator multiplicands; the output
is a 32-bit accumulator, which has the middle bits of the result
[16..47]. The output is within the range <-65536.0 ; 65536.0).

2.38.2 Declaration

The available MLIB_MulNegSat functions have the following declarations:
fraclé_t MLIB MulNegSat Fl6as(acc32_ t a32Accum, fracl6 t fl6Mult)

acc32_t MLIB MulNegSat A32(acc32_ t a32Multl, acc32 t a32Mult2)

2.38.3 Function use

The use of the MLIB_MulNegSat function is shown in the following example:

#include "mlib.h"
static acc32 t a32Ml1, a32M2, a32Result;

void main (void)

{
a32Ml = ACC32(1.5); /* a32M1 = 1.5 */
a32M2 = ACC32(4.1); /* a32M2 = 4.1 */

/* fl6Result = sat(-a32M1 * £32M2) */
a32Result = MLIB MulNegSat A32(a32Ml, a32M2);

2.39 MLIB_MulRnd

The MLIB_MulRnd functions return the rounded product of two multiplicands. The round method is the round to nearest. The
function does not saturate the output. See the following equation:

MLIB MulRnd(a, b) =round(a-*b)
Figure 59. Algorithm formula

2.39.1 Available versions
This function is available in the following versions:

« Fractional output with fractional inputs - the output is the fractional portion of the result; the result is within the range <-1 ; 1).
The inputs are the fractional values only. The result may overflow.
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 Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may overflow.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_MulRnd function are shown in the following table:

Table 40.

Function versions

Function name Input type Result

Mut 1 | mut2 | YPe

MLIB_MulRnd_F16 frac16_t |frac16_t |frac16_t | Product of two 16-bit fractional multiplicands; the output is rounded
to the upper 16 bits of the results [16..31]. The output is within the

range <-1; 1).

MLIB_MulRnd_F16as |acc32_t |frac16_t |frac16_t | Product of a 32-bit accumulator and a 16-bit fractional multiplicand;
the output is a 16-bit fractional value, which is rounded to the upper
16 bits of the fractional portion of the result [16..31]. The output is

within the range <-1; 1).

MLIB_MulRnd_F32Is frac32_t |frac16_t |frac32_t | Product of a 32-bit and a 16-bit fractional multiplicand; the output
is rounded to the upper 32 bits of the fractional portion of the result
[16..47]. The output is within the range <-1 ; 1).

MLIB_MulRnd_F32 frac32_t |frac32_t |frac32_t | Product of two 32-bit fractional multiplicands; the output is rounded
to the upper 32 bits of the results [16..31]. The output is within the

range <-1; 1).

MLIB_MulRnd_A32 acc32_t |acc32_t |acc32_t |Product of two 32-bit accumulator multiplicands; the output is
rounded to the middle bits of the result [16..47]. The output is within
the range <-65536.0 ; 65536.0).

2.39.2 Declaration

The available MLIB_MulRnd functions have the following declarations:

fracl6 t MLIB MulRnd F16(fracle t flé6Multl, fracl6 t fle6Mult2)
fracl6_t MLIB MulRnd Fl6as(acc32_t a32Accum, fracl6_t fleMult)
frac32 t MLIB MulRnd F321s(frac32 t f£32Multl, fraclé t fl6Mult2)
frac32 t MLIB MulRnd F32(frac32 t £32Multl, frac32 t £32Mult2)

acc32_t

MLIB MulRnd A32(acc32 t a32Multl, acc32 t a32Multl)

2.39.3 Function use

The use of the MLIB_MulRnd function is shown in the following example:

#include "mlib.h"
static frac32 t £32Multl, £32Mult2, f32Result;

void main (void)

{
£32Multl FRAC32(0.5) ; /* £32Multl 0.5 */
£f32Mult2 = FRAC32(-0.24564); /* £32Mult2 = -0.24564 */

/* f32Result = round(£32Multl * f32Mult2) */
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£32Mult2) ;

2.40 MLIB_MulRndSat

The MLIB_MulRndSat functions return the rounded product of two multiplicands. The round method is the round to nearest. The
function saturates the output. See the following equation:

Figure 60. Algorithm formula

MLIB_MulRndSat(a, b) =

max, round(a*b) > max
min, round(a*b) <min
round(a*b), else

2.40.1 Available versions

This function is available in the following versions:

 Fractional output with fractional inputs - the output is the fractional portion of the result; the result is within the range <-1; 1).
The inputs are the fractional values only. The result may saturate.

« Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may saturate.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_MulRndSat function are shown in the following table:

Table 41. Function versions

Function name Input type Result Description
Mut 1 | Mat2 | Pe

MLIB_MulRndSat_F16 frac16_t |frac16_t |frac16_t |Product of two 16-bit fractional multiplicands; the output is
rounded to the upper 16 bits of the results [16..31]. The output is
within the range <-1; 1).

MLIB_MulRndSat_F16as acc32_t |[frac16_t |frac16_t |Product of a 32-bit accumulator and a 16-bit fractional
multiplicand; the output is a 16-bit fractional value, which is
rounded to the upper 16 bits of the fractional portion of the result
[16..31]. The output is within the range <-1; 1).

MLIB_MulRndSat_F32Is frac32_t |frac16_t |frac32_t |Product of a 32-bit multiplicand and a 16-bit fractional
multiplicand; the output is rounded to the upper 32 bits of the
fractional portion of the result [16..47]. The output is within the
range <-1; 1).

MLIB_MulRndSat_F32 frac32_t |frac32_t |frac32_t |Product of two 32-bit fractional multiplicands; the output is
rounded to the upper 32 bits of the results [16..31]. The output is
within the range <-1; 1).

MLIB_MulRndSat_A32 acc32_t |acc32_t |acc32_t |Product of two 32-bit accumulator multiplicands; the output is

rounded to the the mid bits of the result [16..47]. The output is
within the range <-65536.0 ; 65536.0).
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2.40.2 Declaration

The available MLIB_MulRndSat functions have the following declarations:
fraclé _t MLIB MulRndSat Fl16(fracl6 t fleMultl, fraclée t fleMult2)
fraclé t MLIB MulRndSat Fl6as(acc32 t a32Accum, fracl6é t fl6Mult)
frac32 t MLIB MulRndSat F321s(frac32 t f32Multl, fraclé6 t fl6Mult2)

frac32 t MLIB MulRndSat F32(frac32 t £32Multl, frac32 t £32Mult2)
acc32 t MLIB MulRndSat A32(acc32 t a32Multl, acc32 t a32Multl)

2.40.3 Function use

The use of the MLIB_MulRndSat function is shown in the following example:

#include "mlib.h"
static frac32 t £32Multl, £32Mult2, f£32Result;

void main (void)

{
£32Multl = FRAC32(-1.0); /* £32Multl
£32Mult2 = FRAC32(-1.0); /* £32Mult2

=1.0 =/
=1.0 =/

/* f£32Result = sat (round(f32Multl * £32Mult2))*/
f32Result = MLIB MulRndSat F32(£32Multl, £32Mult2);

2.41 MLIB_MulNegRnd

The MLIB_MulNegRnd functions return the rounded negative product of two multiplicands. The round method is the round to
nearest. The function does not saturate the output. See the following equation:

MLIB MulNegRnd(a, b) =round(—a*b)

Figure 61. Algorithm formula

2.41.1 Available versions
This function is available in the following versions:

 Fractional output with fractional inputs - the output is the fractional portion of the result; the result is within the range <-1; 1).
The inputs are the fractional values only.

 Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may overflow.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_MulNegRnd function are shown in the following table:

MLIB User's Guide, Rev. 5, 01 November 2021
User Guide 73/110




NXP Semiconductors

Table 42. Function versions

Algorithms in detail

Function name

Input type

Result

Mult. 1 Mult. 2

type

Description

MLIB_MulNegRnd_F16

frac16_t |frac16_t |frac16_t

Negative product of two 16-bit fractional multiplicands; the
output is rounded to the upper 16 bits of the results [16..31]. The
output is within the range <-1; 1).

MLIB_MulNegRnd_F16as

acc32_t |frac16_t |frac16_t

Negative product of a 32-bit accumulator and a 16-bit fractional
multiplicand; the output is a 16-bit fractional value, which is
rounded to the upper 16 bits of the fractional portion of the result
[16..31]. The output is within the range <-1 ; 1).

MLIB_MulNegRnd_F32Is

frac32_t |frac16_t |frac32_t

Negative product of a 32-bit fractional multiplicand and a 16-bit
fractional multiplicand; the output is rounded to the upper 32 bits
of the fractional portion of the result [16..47]. The output is within
the range <-1; 1).

MLIB_MulNegRnd_F32

frac32_t |frac32_t |frac32_t

Negative product of two 32-bit fractional multiplicands; the
outputis rounded to the upper 32 bits of the results [16..31]. The
output is within the range <-1; 1).

MLIB_MulNegRnd_A32

acc32_t |acc32_t |acc32_t

Product of two 32-bit accumulator multiplicands; the output is
rounded to the the middle bits of the result [16..47]. The output
is within the range <-65536.0 ; 65536.0).

2.41.2 Declaration

The available MLIB_MulNegRnd functions have the following declarations:

fraclé _t MLIB MulNegRnd F16(fraclée t fleMultl,
fraclé t MLIB MulNegRnd Flé6as(acc32 t a32Accum,
frac32_ t MLIB MulNegRnd F321s(frac32 t f32Multl,
frac32_t MLIB_MulNegRnd F32 (frac32_ t f£32Multl,

fracle t fleMult2)
fracle t fleMult)
fraclé t fleMult2)
frac32 t £32Mult2)

acc32 t MLIB MulNegRnd A32(acc32 t a32Multl, acc32 t a32Multl)

2.41.3 Function use

The use of the MLIB_MulNegRnd function is shown in the following example:

void main (void)
{
f32Multl

/* f£32Result

static frac32 t £32Multl,

#include "mlib.h"

FRAC32(0.3);
£32Mult2 = FRAC32(-0.5);

round (£32Multl *
f32Result = MLIB MulNegRnd F32 (£32Multl,

f32Mult2,

/* £32Multl
/* £32Mult2

f32Result;

(-f32Mult2)) */
£32Mult2) ;

.3 =/
=0.5 */
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2.42 MLIB_MulNegRndSat

The MLIB_MulNegRndSat functions return the rounded negative product of two multiplicands. The round method is the round to
nearest. The function saturates the output. See the following equation:

max, round( —a* b > max)
MLIB_MulNegRndSat(a, b) = min, round (—a* b <min)
round(—a<b), else

Figure 62. Algorithm formula

2.42.1 Available versions
This function is available in the following versions:

» Fractional output with mixed inputs - the output is the fractional portion of the result; the result is within the range <-1; 1). The
inputs are the accumulator and fractional values. The result may saturate.

» Accumulator output - the output is the accumulator type where the result can be out of the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_MulNegRndSat function are shown in the following table:

Table 43. Function versions

Function name Input type Result Description

Mut1 | mutz | VP8

MLIB_MulNegRndSat_F16as acc32_t |frac16_t |frac16_t | Negative product of a 32-bit accumulator and a 16-bit
fractional multiplicand; the output is rounded to the
upper 16 bits of the fractional portion of the result
[16..31]. The output is within the range <-1; 1).

MLIB_MulNegRndSat_A32 acc32_t |acc32_t |acc32_t |Negative product of two 32-bit accumulator
multiplicands; the output is rounded to the middle 32
bits of the result [16..47]. The output is within the range
<-65536.0 ; 65536.0).

2.42.2 Declaration
The available MLIB_MulNegRndSat functions have the following declarations:
fracl6_t MLIB MulNegRndSat Flé6as(acc32 t a32Accum, fracl6 t fleMult)

acc32 t MLIB MulNegRndSat A32(acc32 t a32Multl, acc32 t a32Mult2)

2.42.3 Function use

The use of the MLIB_MulNegRndSat function is shown in the following example:

#include "mlib.h"
static acc32 t a32Ml, a32M2, a32Result;

void main (void)

{

=5.,5 =/
3.1 */

a32M1l = ACC32(-5.5); /* a32M1
a32M2 = ACC32(3.1); /* a32M2
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/* fl6Result = sat (round(-a32M1 * £32M2)) */
a32Result = MLIB MulNegRndSat A32(a32Ml, a32M2);

2.43 MLIB_Neg

The MLIB_Neg functions return the negative value of the input. The function does not saturate the output. See the

following equation:

Figure 63. Algorithm formula

MLIB Neg(x)=—x

2.43.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_Neg function are shown in the following table:

Table 44. Function versions

Function name Input type Result type Description
MLIB_Neg_F16 frac16_t frac16_t Negative value of a 16-bit fractional value. The output is within the range
<-1;1).
MLIB_Neg_F32 frac32_t frac32_t Negative value of a 32-bit fractional value. The output is within the range
<-1;1).

2.43.2 Declaration

The available MLIB_Neg functions have the following declarations:

fracl6e_t MLIB Neg Flé6(fraclée t fléeVal)
frac32_t MLIB Neg F32(frac32_ t f32Val)

2.43.3 Function use

The use of the MLIB_Neg function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

void main (void)

{

static frac32 t f32val,

f32val = FRAC32(0.85);

/* f32Result = -f32vVal */
f32Result = MLIB Neg F32(f32Val);

f32Result;

/* £32val = 0.85 */
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2.44 MLIB_NegSat

The MLIB_NegSat functions return the negative value of the input. The function saturates the output. See the following equation:

MLIB_NegSat(x) = —x
Figure 64. Algorithm formula

2.44.1 Available versions
The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_NegSat function are shown in the following table:

Table 45. Function versions

Function name Input type Result type Description
MLIB_NegSat_F16 |frac16_t frac16_t Negative value of a 16-bit value. The output is within the range <-1 ; 1).
MLIB_NegSat_F32 |frac32_t frac32_t Negative value of a 32-bit value. The output is within the range <-1 ; 1).

2.44.2 Declaration

The available MLIB_NegSat functions have the following declarations:

fracl6e t MLIB NegSat Fl6(fracl6 t fléVal)
frac32 t MLIB NegSat F32(frac32 t f32val)

2.44.3 Function use

The use of the MLIB_NegSat function is shown in the following example:

#include "mlib.h"
static frac32 t f32vVal, f32Result;

void main (void)
{

f32val FRAC32 (-1.0) ; /* £32val = -1.0%*/

/* f32Result = sat (-f32val) */
f32Result = MLIB NegSat F32(f32Val);

2.45 MLIB_Rcp

The MLIB_Rcp functions return the reciprocal value for the input value. The function does not saturate the output. See the
following equation:

MLIB User's Guide, Rev. 5, 01 November 2021
User Guide 771110




NXP Semiconductors

Algorithms in detail

MLIB_Rep(x) =4

Figure 65. Algorithm formula

max, x=0

X, else

2.45.1 Available versions

This function is available in the following versions:

» Accumulator output with fractional input - the output is the accumulator type, where the absolute value of the result is greater
than or equal to 1. The input is the fractional type.

The available versions of the MLIB_Rcp function are shown in the following table.

Table 46. Function versions

Function name Input type Result type

Description

MLIB_Rcp_A32s frac16_t acc32_t

Reciprocal for a 16-bit fractional value; the output is a 32-bit accumulator
value. The absolute value of the output is greater than or equal to 1. The
division is performed with 32-bit accuracy.

MLIB_Rcp1_A32s frac16_t acc32_t

Reciprocal for a 16-bit fractional value; the output is a 32-bit accumulator
value. The absolute value of the output is greater than or equal to 1. Faster
version, where the division is performed with 16-bit accuracy.

2.45.2 Declaration
The available MLIB_Rcp functions have the following declarations:
acc32_t MLIB Rcp A32s(fracl6_t flé6Denom)

acc32_t MLIB Rcpl A32s(fracl6_t flé6Denom)

2.45.3 Function use

The use of the MLIB_Rcp function is shown in the following example:

#include "mlib.h"

static acc32 t a32Result;
static fracl6_t flé6Denom;

void main (void)
{

fl6Denom = FRAC16(0.354); /* fl6Denom = 0.354 */

/* a32Result = 1/fl6Denom */
a32Result = MLIB Rcpl A32s(fl6Denom) ;

2.46 MLIB_Rcp1Q

The MLIB_Rcp1Q functions return the single quadrant reciprocal value for the input value. The input value must be a nonnegative
number, otherwise the function returns undefined results. The function does not saturate the output. See the following equation:
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max, x=0
MLIB_ReplQ(x) =4 ;
T x>0

Figure 66. Algorithm formula

2.46.1 Available versions
This function is available in the following versions:

» Accumulator output with fractional input - the output is the accumulator type, where the result is greater than or equal to 1.
The function is not defined for negative inputs. The input is the fractional type.

The available versions of the MLIB_Rcp1Q function are shown in the following table.

Table 47. Function versions

Function name Input type Result type Description

MLIB_Rcp1Q_A32s frac16_t acc32_t Reciprocal for a nonnegative 16-bit fractional value; the output is a
positive 32-bit accumulator value. The output is greater than or equal to
1. The division is performed with 32-bit accuracy.

MLIB_Rcp1Q1_A32s frac16_t acc32_t Reciprocal for a nonnegative 16-bit fractional value; the output is a
positive 32-bit accumulator value. The output is greater than or equal to
1. Faster version, where the division is performed with 16-bit accuracy.

2.46.2 Declaration

The available MLIB_Rcp1Q functions have the following declarations:
acc32_t MLIB RcplQ A32s(fracl6 t flé6Denom)

acc32_t MLIB RcplQl A32s(fraclé t flé6Denom)

2.46.3 Function use

The use of the MLIB_Rcp1Q function is shown in the following example:

#include "mlib.h"

static acc32 t a32Result;
static fraclé6_t flé6Denom;

void main (void)
{
fl6Denom = FRAC16(0.354) ; /* fl6Denom = 0.354 */

/* a32Result = 1/fl6Denom */
a32Result = MLIB RcplQl A32s(fléDenom) ;

2.47 MLIB_Rnd

The MLIB_Rnd functions round the input to the nearest value to meet the return type's size. The function does not saturate the
output. See the following equation:
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MLIB Rnd(x) =round(x)
Figure 67. Algorithm formula

2.47.1 Available versions

This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_Rnd function are shown in the following table.

Table 48. Function versions

Function name Input type Result type Description

is within the range <-1; 1).

MLIB_Rnd_F16l frac32_t frac16_t Rounding of a 32-bit fractional value to a 16-bit fractional value. The output

2.47.2 Declaration

The available MLIB_Rnd functions have the following declarations:

fracl6_t MLIB_Rnd F161 (frac32_t £32Val)

2.47.3 Function use

The use of the MLIB_Rnd function is shown in the following example:

#include "mlib.h"

static frac32 t f32val;
static fraclé t fl6Result;

void main (void)
{
£32vVal = FRAC32(0.85); /* £32val = 0.85 */

/* fl6Result = round(f32Val)*/
fl6Result = MLIB Rnd F161(f32val);

2.48 MLIB_RndSat

The MLIB_RndSat functions round the input to the nearest value to meet the return type's size. The function saturates the output.

See the following equation:

MLIB_RndSat(x) =round(x)
Figure 68. Algorithm formula

2.48.1 Available versions

This function is available in the following versions:
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» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_RndSat function are shown in the following table.

Table 49. Function versions

Function name Input type Result type Description

MLIB_RndSat_F 16l frac32_t frac16_t Rounding of a 32-bit fractional value to a 16-bit fractional value. The
output is within the range <-1 ; 1).

2.48.2 Declaration

The available MLIB_RndSat functions have the following declarations:

fracl6_t MLIB RndSat F161 (frac32 t f32Val)

2.48.3 Function use

The use of the MLIB_RndSat function is shown in the following example:

#include "mlib.h"

static frac32 t f32val;
static fraclé t fl6Result;

void main (void)
{
f32val = FRAC32(0.9997996) ; /* £32vVal = 0.9997996 */

/* fl6Result = sat(round(f32val)) */
fl6Result = MLIB RndSat F161 (f32val);

249 MLIB_Sat

The MLIB_Sat functions return the fractional portion of the accumulator input. The output is saturated if necessary. See the
following equation:

1, x>1
MLIB_Sat(x)={"1 x<-1
X, else

Figure 69. Algorithm formula

2.49.1 Available versions
This function is available in the following versions:

« Fractional output with accumulator input - the output is the fractional portion of the result; the result is within the range <-1 ;
1). The result is saturated.

The available versions of the MLIB_Sat function are shown in the following table.
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Function name

Input type

Result type

Description

MLIB_Sat_F16a

acc32_t

frac16_t

Saturation of a 32-bit accumulator value to a 16-bit fractional value. The

output is within the range <-1 ; 1).

2.49.2 Declaration

The available MLIB_Sat functions have the following declarations:

fracl6e_t MLIB Sat Flé6a(acc32_t a32Accum)

2.49.3 Function use

The use of the MLIB_Sat function is shown in the following example:

#include

{

"mlib.h"

void main (void)

/* fl6Result =

static acc32 t a32Accum;
static fracl6 t fl6Result;

a32Accum = ACC32(5.6);

/* a32Accum = 5.6 */

sat (a32Accum) */
fl6Result = MLIB Sat_ Flé6a (a32Accum) ;

2.50 MLIB_Sh1L

The MLIB_Sh1L functions return the arithmetically one-time-shifted value to the left. The function does not saturate the output.
See the following equation:

Figure 70. Algorithm formula

MLIB ShIL(x)=x<1

2.50.1 Available versions

The function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_Sh1L function are shown in the following table.

Table 51. Function versions

Function name Input type Result type Description
MLIB_Sh1L_F16 |frac16_t frac16_t Shift of a 16-bit fractional value by one time to the left. The output is within the
range <-1; 1).
MLIB_Sh1L_F32 |frac32_t frac32_t Shift of a 32-bit fractional value by one time to the left. The output is within the

range <-1; 1).
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2.50.2 Declaration
The available MLIB_Sh1L functions have the following declarations:
fraclé_t MLIB ShlL Fl6(fracl6 t fléVval)

frac32 t MLIB ShlL F32(frac32 t f32Val)

2.50.3 Function use

The use of the MLIB_Sh1L function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result, f32val;
void main (void)

{

£32val = FRAC32(-0.354); /* f32val = -0.354 */

/* £32Result = f£32Val << 1 */
f32Result = MLIB ShlL F32(£f32Val);

2.51 MLIB_Sh1LSat

The MLIB_Sh1LSat functions return the arithmetically one-time-shifted value to the left. The function saturates the output. See the

following equation:

1, x>0.5
MLIB_ShiLSat(x)=4{ —L x<-0.5
x <, else

Figure 71. Algorithm formula

2.51.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1). The result
may saturate.

The available versions of the MLIB_Sh1LSat function are shown in the following table.

Table 52. Function versions

Function name Input type Result type Description

the range <-1; 1).

MLIB_Sh1LSat_F16 | frac16_t frac16_t Shift of a 16-bit fractional value by one time to the left. The output is within

the range <-1; 1).

MLIB_Sh1LSat_F32 | frac32_t frac32_t Shift of a 32-bit fractional value by one time to the left. The output is within
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2.51.2 Declaration

The available MLIB_Sh1LSat functions have the following declarations:

fraclé_t MLIB ShlLSat Fl6(fracle t fléVal)
frac32 t MLIB ShlLSat F32(frac32 t f32val)

2.51.3 Function use

The use of the MLIB_Sh1LSat function is shown in the following example:

#include "mlib.h"

static fracl6 t fl6Result, flévVal;
void main (void)

{

fléval = FRAC16(0.354); /* fleval = 0.354 */

/* fl6Result = sat (flé6Val << 1) */
fl6Result = MLIB ShlLSat F16(fléval);

2.52 MLIB_Sh1R

The MLIB_Sh1R functions return the arithmetically one-time-shifted value to the right. See the following equation:

MLIB_ShIR (x) =x>> 1

Figure 72. Algorithm formula

2.52.1 Available versions
This function is available in the following versions:
» Fractional output - the output is the fractional portion of the result; the result is within the range <-0.5 ; 0.5).

The available versions of the MLIB_Sh1R function are shown in the following table.

Table 53. Function versions

Function name Input type Result type Description

MLIB_Sh1R_F16 |frac16_t frac16_t Shift of a 16-bit fractional value by one time to the right. The output is within
the range <-0.5 ; 0.5).

MLIB_Sh1R_F32 |frac32_t frac32_t Shift of a 32-bit fractional value by one time to the right. The output is within
the range <-0.5 ; 0.5).

2.52.2 Declaration

The available MLIB_Sh1R functions have the following declarations:

fraclé t MLIB ShlR F16(fracl6e t flé6Val)
frac32 t MLIB_ShlR F32(frac32_ t f32Val)
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The use of the MLIB_Sh1R function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result, f32Val;
void main (void)

{

f32val = FRAC32(-0.354); /* f£32val = -0.354 */

/* £32Result = f32val >> 1 */
£32Result = MLIB ShlR F32(£32val);

2.53 MLIB_ShL

Algorithms in detail

The MLIB_ShL functions return the arithmetically shifted value to the left a specified number of times. The function does not

saturate the output. See the following equation:

MLIB_ShL(x,n) =x<n

Figure 73. Algorithm formula

2.53.1 Auvailable versions

This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

The available versions of the MLIB_ShL function are shown in the following table.

Table 54. Function versions

Function name Input type Result Description

Value | Shift type

is within the range <-1; 1).

MLIB_ShL_F16 |frac16_t |uint16_t |frac16_t | Shift of a 16-bit fractional value to the left by a number of times given by the
second argument; the shift is allowed within the range <0 ; 15>. The output

is within the range <-1; 1).

MLIB_ShL_F32 |frac32_t |uint16_t |frac32_t | Shift of a 32-bit fractional value to the left by a number of times given by the
second argument; the shift is allowed within the range <0 ; 31>. The output

2.53.2 Declaration

The available MLIB_ShL functions have the following declarations:

fracl6e_t MLIB ShL Fl6(fraclée t fleVal, uintl6 t ul6Sh)
frac32_t MLIB_ShL F32 (frac32_t f32Val, uintl6_t ulé6Sh)
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2.53.3 Function use

The use of the MLIB_ShL function is shown in the following example:

Algorithms in detail

#include "mlib.h"

static fraclé6 t fl6Result, fléVal;
static uintl6_t ul6Sh;

void main (void)

{

fl6vVal = FRAC16(-0.354); /* fleval = -0.354 */
ul6Sh = 6; /* uléSh = 6 */
/* fl6Result = fl6Val << ul6Sh */

fl6Result = MLIB ShL Fl16(fl6Val, ul6Sh);

2.54 MLIB_ShLSat

The MLIB_ShLSat functions return the arithmetically shifted value to the left a specified number of times. The function saturates

the output. See the following equation:

L x> o

MLIB_ShLSat(x,n) ={ —1, X<
x <K, else

Figure 74. Algorithm formula

2.54.1 Available versions

This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.

The available versions of the MLIB_ShLSat function are shown in the following table.

Table 55. Function versions

Function name Input type Result

Value | shit | YP°

Description

MLIB_ShLSat_F16 |frac16_t |uint16_t |frac16_t | Shift of a 16-bit fractional value to the left by a number of times given

by the second argument; the shift is allowed within the range <0 ; 15>.
The output is within the range <-1; 1).

MLIB_ShLSat_F32 |frac32_t

uint16_t |frac32_t | Shift of a 32-bit fractional value to the left by a number of times given

by the second argument; the shift is allowed within the range <0 ; 31>.
The output is within the range <-1; 1).
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2.54.2 Declaration
The available MLIB_ShLSat functions have the following declarations:
fraclé_t MLIB ShLSat Fl6(fracl6 t flé6Val, uintl6 t ulé6Sh)

frac32 t MLIB ShLSat F32(frac32 t f32Val, uintl6_t ul6Sh)

2.54.3 Function use

The use of the MLIB_ShLSat function is shown in the following example:

Algorithms in detail

#include "mlib.h"

static fracl6 t fl6Result, flévVal;
static uintl6 t ul6Sh;

void main (void)

{

fl6Val = FRAC16(-0.003); /* fleval = -0.003 */
ul6sSh = 6; /* uléSh = 6 */
/* fl6Result = sat(flevVal << ul6Sh) */

fl6Result = MLIB ShLSat F16(fl6Val, ulé6Sh);

2.55 MLIB_ShR

The MLIB_ShR functions return the arithmetically shifted value to the right a specified number of times. See the following equation:

MLIB_ShR(x,n) =x>n

Figure 75. Algorithm formula

2.55.1 Auvailable versions

This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1).

The available versions of the MLIB_ShR function are shown in the following table.

Table 56. Function versions

Function name Input type Result Description
valie | shit | UP°
MLIB_ShR_F16 |frac16_t |uint16_t |frac16_t | Shift of a 16-bit fractional value to the right by a number of times given by

the second argument; the shift is allowed within the range <0 ; 15>. The
output is within the range <-1; 1).

MLIB_ShR_F32

frac32_t |uint16_t

frac32_t

Shift of a 32-bit fractional value to the right by a number of times given by
the second argument; the shift is allowed within the range <0 ; 31>. The
output is within the range <-1; 1).
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2.55.2 Declaration
The available MLIB_ShR functions have the following declarations:
fraclé t MLIB ShR F16(fracl6 t fl6Val, uintl6 t ulé6Sh)

frac32 t MLIB ShR F32(frac32 t f32Val, uintl6_t ulé6Sh)

2.55.3 Function use

The use of the MLIB_ShR function is shown in the following example:

#include "mlib.h"

static fracl6 t fl6Result, fléval;
static uintl6 t ul6Sh;

void main (void)

{
fl6val = FRAC32 (-0.354); /* fléval = -0.354 */
uléSh = 8; /* uléSh = 8 */

/* fl6Result = fl6Val >> ul6Sh */
fl6Result = MLIB ShR F16(fl6Val, ul6Sh);

2.56 MLIB_ShLBi

The MLIB_ShLBI functions return the arithmetically shifted value to the left a specified number of times. If the number of
shifts is positive, the shift is performed to the left; if negative, to the right. The function does not saturate the output. See the
following equation:

MLIB_ShLBi(x,n) =x<n

Figure 76. Algorithm formula

2.56.1 Available versions
The function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_ShLBi function are shown in the following table.

Table 57. Function versions

Function name Input type Result Description

type

Value Shift

MLIB_ShLBi_F16 |frac16_t |int16_t |frac16_t |Bidirectional shiftof a 16-bit fractional value to the left by a number of times
given by the second argument; if the second argument is negative, the
shift is performed to the right. The shift is allowed within the range <-15;
15>. The output is within the range <-1; 1).

Table continues on the next page...
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Table 57. Function versions (continued)

Function name Input type Result Description

type

Value Shift

MLIB_ShLBi_F32 |frac32_t |int16_t |frac32_t |Bidirectional shift of a 32-bit fractional value to the left by a number of times
given by the second argument; if the second argument is negative, the
shift is performed to the right. The shift is allowed within the range <-31 ;
31>. The output is within the range <-1; 1).

2.56.2 Declaration

The available MLIB_ShLBi functions have the following declarations:
fracl6e_t MLIB ShLBi Fl6(fraclé6_ t fléeVal, intlé_t il6Sh)

frac32 t MLIB_ShLBi_ F32 (frac32 t f32val, intlé t i16Sh)

2.56.3 Function use

The use of the MLIB_ShLBi function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result, £32Val;
static intl6 t il16Sh;

void main (void)

{
£f32Val = FRAC32(-0.354); /* £32val = -0.354 */
iléesh = -3; /* 116Sh = -3 */

/* f£32Result = £32Val << i16Sh */
f32Result = MLIB ShLBi F32(f32Val, i16Sh);

2.57 MLIB_ShLBiSat

The MLIB_ShLBiSat functions return the arithmetically shifted value to the left a specified number of times. If the number of shifts
is positive, the shift is performed to the left; if negative, to the right. The function saturates the output. See the following equation:

L x>5 A n>0
MLIB_ShLBiSat(x,n) ={ —, X< A n>0
x <L, else

Figure 77. Algorithm formula

2.57.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_ShLBiSat function are shown in the following table.
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Table 58. Function versions

Function name Input type Result Description

value | shit | YP°

MLIB_ShLBiSat_F16 |frac16_t |int16_t |frac16_t |Bidirectional shift of a 16-bit fractional value to the left by a number
of times given by the second argument; if the second argument is
negative, the shift is performed to the right. The shift is allowed within
the range <-15; 15>. The output is within the range <-1 ; 1).

MLIB_ShLBiSat_F32 frac32_t |int16_t |frac32_t | Bidirectional shift of a 32-bit fractional value to the left by a number
of times given by the second argument; if the second argument is
negative, the shift is performed to the right. The shift is allowed within
the range <-31; 31>. The output is within the range <-1 ; 1).

2.57.2 Declaration
The available MLIB_ShLBiSat functions have the following declarations:
fraclé_t MLIB ShLBiSat Fl6(fracl6 t flé6Val, intl6_t il6Sh)

frac32 t MLIB ShLBiSat F32 (frac32 t £32Val, intlé6_t i16Sh)

2.57.3 Function use

The use of the MLIB_ShLBiSat function is shown in the following example:

#include "mlib.h"

static fraclé6 t fl6Result, flévVal;
static intl6 t il6Sh;

void main (void)

{
fléval = FRAC16(-0.354); /* fleval = -0.354 */
il6sh = 14; /* 116Sh = 14 */

/* fl6Result = sat(flé6Val << i16Sh) */
fl6Result = MLIB ShLBiSat F16(fl6Vval, il6Sh);

2.58 MLIB_ShRBi

The MLIB_ShRBi functions return the arithmetically shifted value to the right a specified number of times. If the number of
shifts is positive, the shift is performed to the right; if negative, to the left. The function does not saturate the output. See the
following equation:

MLIB ShRBi(x,n) =x>n

Figure 78. Algorithm formula

2.58.1 Available versions

This function is available in the following versions:
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» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_ShRBi function are shown in the following table.

Table 59. Function versions

Function name Input type Result Description

value | shit | YP®

MLIB_ShRBIi_F16 |frac16_t |int16_t |frac16_t |Bidirectional shift of a 16-bit fractional value to the right by a number of
times given by the second argument; if the second argument is negative,
the shiftis performed to the left. The shift is allowed within the range <-15;
15>. The output is within the range <-1; 1).

MLIB_ShRBIi_F32 |[frac32_t |int16_t |frac32_t |Bidirectional shift of a 32-bit fractional value to the right by a number of
times given by the second argument; if the second argument is negative,
the shiftis performed to the left. The shift is allowed within the range <-31 ;
31>. The output is within the range <-1; 1).

2.58.2 Declaration

The available MLIB_ShRBI functions have the following declarations:
fraclé_t MLIB ShRBi Fl6(fraclé t fl6Val, intl6 t 116Sh)

frac32 t MLIB ShRBi F32(frac32 t f32Val, intlé_t il6Sh)

2.58.3 Function use

The use of the MLIB_ShRBi function is shown in the following example:

#include "mlib.h"

static frac32 t f32Result, f32Val;
static intl6 t il6Sh;

void main (void)

{
f32val = FRAC32(0.354); /* £32In = 0.354 */
ilé6sh = 8; /* iléSh 8 */

/* f£32Result = £32Val >> il6Sh */
f32Result = MLIB ShRBi F32(f£f32Val, il6Sh);

2.59 MLIB_ShRBiSat

The MLIB_ShRBiSat functions return the arithmetically shifted value to the right a specified number of times. If the number of shifts
is positive, the shift is performed to the right; if negative, to the left. The function saturates the output. See the following equation:
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1, x>5 A n<0
MLIB_ShRBiSat(x,n) ={ -1, x<;—,¥ A n<0
x>n, else

Figure 79. Algorithm formula

2.59.1 Available versions

This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may saturate.

The available versions of the MLIB_ShRBiSat function are shown in the following table.

Table 60. Function versions

Result

type

Function name Input type

Shift

Value

Description

MLIB_ShRBiSat_F16 |frac16_t |int16_t |frac16_t

Bidirectional shift of a 16-bit fractional value to the right by a number
of times given by the second argument; if the second argument is
negative, the shift is performed to the left. The shift is allowed within
the range <-15; 15>. The output is within the range <-1 ; 1).

MLIB_ShRBiSat_F32 |frac32_t |int16_t |frac32_t

Bidirectional shift of a 32-bit fractional value to the right by a number
of times given by the second argument; if the second argument is
negative, the shift is performed to the left. The shift is allowed within
the range <-31; 31>. The output is within the range <-1 ; 1).

2.59.2 Declaration

The available MLIB_ShRBiSat functions have the following declarations:

fracl6_t MLIB_ShRBiSat Fl16(fracl6_ t flé6Val, intl6_t i16Sh)
frac32 t MLIB ShRBiSat F32(frac32 t f£32vVal, intl6_t il6Sh)

2.59.3 Function use

The use of the MLIB_ShRBiSat function is shown in the following example:

include "mlib.h"

static frac32_t f32Result, f32val;
static intl6 t 116Sh;

void main (void)

{
£32vVal = FRAC32(-0.354);
il6Sh = 13;

/* f32Result =

/* f£32val =
/* 116Sh =

sat (f32val >> 116Sh)
f32Result = MLIB ShRBiSat F32(f32Val, il6Sh);

-0.354 */
13 */

*/
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2.60 MLIB_Sign

The MLIB_Sign functions return the sign of the input. See the following equation:

1, x>0
MLIB Sign(x) =1 0, x=0
-1, x<0

Figure 80. Algorithm formula

2.60.1 Available versions
This function is available in the following versions:
 Fractional output - the output is the fractional portion of the result; the result is within the range <-1; 1).

The available versions of the MLIB_Sign function are shown in the following table.

Table 61. Function versions

Function name Input type Result type Description
MLIB_Sign_F16 frac16_t frac16_t Sign of a 16-bit fractional value. The output is within the range <-1; 1).
MLIB_Sign_F32 frac32_t frac32_t Sign of a 32-bit fractional value. The output is within the range <-1; 1).

2.60.2 Declaration

The available MLIB_Sign functions have the following declarations:
fracl6e_t MLIB Sign Flé6(fracle t fléeVal)

frac32_t MLIB_Sign_ F32 (frac32_t f£32Val)

2.60.3 Function use

The use of the MLIB_Sign function is shown in the following examples:

Fixed-point version:
#include "mlib.h"
static frac32 t £32In, f32Result;
void main (void)
{

£32In = FRAC32(-0.95); /* £32In = -0.95 */

/* £32Result = sign(£32In)*/
f32Result = MLIB Sign F32(£321In);

2.61 MLIB_Sub

The MLIB_Sub functions subtract the subtrahend from the minuend. The function does not saturate the output. See the
following equation:
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Figure 81. Algorithm formula

MLIB Sub(a, b)=a—b

2.61.1 Available versions

This function is available in the following versions:

« Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result

may overflow.

» Accumulator output with fractional inputs - the output is the accumulator type, where the result can be out of the range <-1;
1). The inputs are the fractional values only.

» Accumulator output with mixed inputs - the output is the accumulator type, where the result can be out of the range <-1 ; 1).
The inputs are the accumulator and fractional values. The result may overflow.

The available versions of the MLIB_Sub function are shown in the following table.

Table 62. Function versions

Function name

Input type

Minuend Subtrahend

Result Description

type

MLIB_Sub_F16 frac16_t frac16_t frac16_t | Subtraction of a 16-bit fractional subtrahend from a 16-bit
fractional minuend. The output is within the range <-1; 1).
MLIB_Sub_F32 frac32_t frac32_t frac32_t | Subtraction of a 32-bit fractional subtrahend from a 32-bit

fractional minuend. The output is within the range <-1 ; 1).

MLIB_Sub_A32ss

frac16_t frac16_t

acc32_t | Subtraction of a 16-bit fractional subtrahend from a 16-bit
fractional minuend; the result is a 32-bit accumulator. The output
may be out of the range <-65536 ; 65536).

MLIB_Sub_A32as

acc32_t frac16_t

acc32_t | Subtraction of a 16-bit fractional subtrahend from a 32-
bit accumulator. The output may be out of the range

<-65536 ; 65536).

2.61.2 Declaration

The available MLIB_Sub functions have the following declarations:

fraclé_t MLIB Sub F16(fracl6 t fl16Min, fracl6 t fl6Sub)
frac32_t MLIB Sub F32(frac32 t £32Min, frac32 t f32Sub)
acc32_t MLIB Sub A32ss(fracle_t fleMin, fracl6_t flé6Sub)
acc32_t MLIB Sub_A32as(acc32_t a32Accum, fracl6_t fl6Sub)

2.61.3 Function use

The use of the MLIB_Sub function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static acc32 t a32Accum, a32Result;
static fracl6_t fl6Sub;

void main (void)
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a32Accum = ACC32(4.5); /* a32Accum = 4.5 */

fléeSub = FRAC16(0.4); /* fl6Sub = 0.4 */

/* a32Result = a32Accum - fl6Sub */
a32Result = MLIB Sub A32as (a32Accum, f16Sub) ;

2.62 MLIB_SubSat

The MLIB_SubSat functions subtract the subtrahend from the minuend. The function saturates the output. See the
following equation:

L a—b>1
MLIB_SubSat(a, b) ={ —L a—-b<-1
a—b, else

Figure 82. Algorithm formula

2.62.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_SubSat function are shown in the following table.

Table 63. Function versions

Function name Input type Result Description

type

Minuend Subtrahend

MLIB_SubSat_F16 frac16_t frac16_t frac16_t | Subtraction of a 16-bit fractional subtrahend from a 16-bit
fractional minuend. The output is within the range <-1; 1).

MLIB_SubSat_F32 frac32_t frac32_t frac32_t | Subtraction of a 32-bit fractional subtrahend from a 32-bit
fractional minuend. The output is within the range <-1; 1).

2.62.2 Declaration
The available MLIB_SubSat functions have the following declarations:
fraclé t MLIB SubSat Fl6(fraclé t fl6Min, fracl6 t f16Sub)

frac32 t MLIB SubSat F32(frac32 t f32Min, frac32 t £32Sub)

2.62.3 Function use

The use of the MLIB_SubSat function is shown in the following example:

#include "mlib.h"
static frac32 t £32Min, £32Sub, f32Result;

void main (void)

{
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£32Min = FRAC32(-0.5); /* £32Min = -0.5 */
£32Sub FRAC32(0.8) ; /* £32Sub 0.8 */

/* f£32Result = sat(f32Min - £32Sub) */
f32Result = MLIB SubSat F32(£32Min, £32Sub) ;

2.63 MLIB_Sub4

The MLIB_Sub4 functions return the subtraction of three subtrahends from the minuend. The function does not saturate the output.
See the following equation:

MLIB Sub4(a,b,c,d)=a—b—c—d
Figure 83. Algorithm formula

2.63.1 Available versions
This function is available in the following versions:

 Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may overflow.

The available versions of the MLIB_Sub4 function are shown in the following table.

Table 64. Function versions

Function name Input type Result Description

Minuend | Sub.1 | Sub.2 | Sub.3 | YP®

MLIB_Sub4_F16 |frac16_t frac16_t |frac16_t |frac16_t |frac16_t | Subtraction of three 16-bit fractional
subtrahends from 16-bit fractional minuend. The
output is within the range <-1; 1).

MLIB_Sub4_F32 |frac32_t frac32_t |frac32_t |frac32_t |frac32_t | Subtraction of three 32-bit fractional
subtrahends from 32-bit fractional minuend. The
output is within the range <-1; 1).

2.63.2 Declaration

The available MLIB_Sub4 functions have the following declarations:

fracl6_t MLIB Sub4 F16(fracl6_t fle6Min, fracle_t fle6Subl, fracl6_ t fl6Sub2, fracl6_t fl6Sub3)
frac32 t MLIB Sub4 F32(frac32 t £32Min, frac32 t £32Subl, frac32 t f32Sub2, frac32 t f£32Sub3)

2.63.3 Function use

The use of the MLIB_Sub4 function is shown in the following examples:

Fixed-point version:
#include "mlib.h"

static fracl6 t fl6Result, fléMin, f16Subl, fl6Sub2, fl6Sub3;

void main (void)
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fleMin = FRAC16(0.2); /* fleMin = 0.2 */

fl6Subl = FRAC16(0.3); /* fl6Subl = 0.3 */
fl6Sub2 = FRAC16(-0.5); /* £16Sub2 = -0.5 */
f16Sub3 = FRAC16(0.2); /* £16Sub3 = 0.2 */

/* fl6Result = sat(fléeMin - fl6Subl - fl6Sub2 - f16Sub3) */
fl6Result = MLIB Sub4 F16(fl6Min, fl6Subl, f16Sub2, fl6Sub3);

2.64 MLIB_Sub4Sat

The MLIB_Sub4Sat functions return the subtraction of three subtrahends from the minuend. The function saturates the output.
See the following equation:

1, a—b—c—d>1
MLIB Sub4Sat(a, b, c,d) = -1 a—b—c—d<-1
a—b—c—d, else

Figure 84. Algorithm formula

2.64.1 Available versions
This function is available in the following versions:

» Fractional output - the output is the fractional portion of the result; the result is within the range <-1 ; 1). The result
may saturate.

The available versions of the MLIB_Sub4Sat function are shown in the following table.

Table 65. Function versions

Function name Input type Result Description

Minuend | Sub.1 | Sub.2 | Sub.3 | P°

MLIB_Sub4Sat_F16 |frac16_t frac16_t |frac16_t |frac16_t |frac16_t | Subtraction of three 16-bit fractional
subtrahends from 16-bit fractional minuend.
The output is within the range <-1; 1).

MLIB_Sub4Sat_F32 frac32_t frac32_t |frac32_t |frac32_t |[frac32_t |Subtraction of three 32-bit fractional
subtrahends from 32-bit fractional minuend.
The output is within the range <-1; 1).

2.64.2 Declaration

The available MLIB_Sub4Sat functions have the following declarations:

fracl6e_t MLIB Subd4Sat F16(fracl6 t fl6Min, fraclé6 t fl6Subl, fraclé6 t fl6Sub2, fracl6 t flé6Sub3)

frac32_t MLIB_Sub4Sat_F32(frac32_t f32Min, frac32_t f£32Subl, frac32 t £32Sub2, frac32_ t £32Sub3)
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#include "mlib.h"
static frac32 t f32Result,

void main (void)

{
f32Min = FRAC32(0.2);
£32Subl = FRAC32(0.8);
£32Sub2 FRAC32(-0.1);
£32Sub3 = FRAC32(0.7);

f£32Min, £32Subl, f32Sub2, f32Sub3;

/* £32Min = 0.2 */
/* £32Subl = 0.8 */
/* £32Sub2 =01 =/
/* £32Sub3 .7 =/

/* f£32Result = sat (£32Min - £32Subl - £32Sub2 - £32Sub3) */

f32Result = MLIB Subd4Sat F32(£32Min, £32Subl, £32Sub2, £32Sub3);
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A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two states: TRUE (1) or FALSE (0). Its definition

is as follows:
typedef unsigned short bool t;

The following figure shows the way in which the data is stored by this type:

Table 66. Data storage

15 14 13 12 11 10 9 8 7 6 0
Value Unused Logi
cal
TRUE O lolo|o|o0o|O0O|O]|O]oO]|oO 1
0 0 0
FALSE 0 0 0 0 0 0 0 0 0 0 0
0 0 0

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within the range <0 ; 255>. Its definition is

as follows:
typedef unsigned char uint8_t;

The following figure shows the way in which the data is stored by this type:

Table 67. Data storage

Value Integer

255 1 1 1 1 1

Table continues on the next page...
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Library types
Table 67. Data storage (continued)
11 0 0 0 1 1
0
124 0 1 1 1 0
7
159 1 0 0 1 1
9
A.3 uint16_t

The uint16_t type is an unsigned 16-bit integer type. It is able to store the variables within the range <0 ; 65535>. Its definition is

as follows:

typedef unsigned short uintlé6 t;

The following figure shows the way in which the data is stored by this type:

Table 68. Data storage

15 14 13 12 1" 10 7 0
Value Integer

65535 1 1 1 1 1 1 1 1
F

5 0 0 0 0 0 0 0 1
0

15518 0 0 1 1 1 1 1 0
3

40768 1 0 0 1 1 1 0 0
9
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A4 uint32_t

Library types

The uint32_t type is an unsigned 32-bit integer type. Itis able to store the variables within the range <0 ; 4294967295>. Its definition

is as follows:

typedef unsigned long uint32 t;

The following figure shows the way in which the data is stored by this type:

Table 69. Data storage

31 24 23 16 15 7 0
Value Integer
4294967295 F F F F
2147483648 8 0 0 0
55977296 0 3 2 0
3451051828 C D D 4
A.5 int8_t

The int8_t type is a signed 8-bit integer type. It is able to store the variables within the range <-128 ; 127>. Its definition is as follows:

typedef char int8 t;

The following figure shows the way in which the data is stored by this type:

Table 70. Data storage

7 6 5 3 0
Value Sign Integer

127 0 1 1 1 1
7

-128 1 0 0 0 0
8

60 0 0 1 1 0
3

Table continues on the next page...
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Library types

Table 70. Data storage (continued)

-97 1 0 0 1 1 1 1 1

A.6 int16_t

The int16_t type is a signed 16-bit integer type. It is able to store the variables within the range <-32768 ; 32767>. Its definition is
as follows:

typedef short intl6 t;

The following figure shows the way in which the data is stored by this type:

Table 71. Data storage

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Value Sign Integer
32767 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 F F F
-32768 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 0 0 0
15518 0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0
3 Cc 9 E
-24768 1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0
9 F 4 0
A.7 int32_t

The int32_t type is a signed 32-bit integer type. It is able to store the variables within the range <-2147483648 ; 2147483647>. Its
definition is as follows:

typedef long int32 t;

The following figure shows the way in which the data is stored by this type:

Table 72. Data storage

Table continues on the next page...
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Library types
Table 72. Data storage (continued)
31 24 23 16 15 8 7 0
Value S Integer
2147483647 7 F F F F F F F
-2147483648 8 0 0 0 0 0 0 0
55977296 0 3 5 6 2 5 5 0
-843915468 C D B 2 D F 3 4
A.8 frac8_t

The frac8_t type is a signed 8-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:
typedef char frac8 t;

The following figure shows the way in which the data is stored by this type:

Table 73. Data storage

7 6 5 4 3 2 1 0
Value Sign Fractional
0.99219 0 1 1 1 1 1 1 1
7 F
-1.0 1 0 0 0 0 0 0 0
8 0
0.46875 0 0 1 1 1 1 0 0
3 C
-0.75781 1 0 0 1 1 1 1 1
9 F

To store a real number as frac8_t, use the FRAC8 macro.
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Library types

A.9 frac16_t

The frac16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is
as follows:

typedef short fraclé6 t;

The following figure shows the way in which the data is stored by this type:

Table 74. Data storage

%5 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Value Sign Fractional
0.99997 0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1
7 F F F
-1.0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
8 0 0 0
0.47357 0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0
3 Cc 9 E
-0.75586 1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0
9 F 4 0

To store a real number as frac16_t, use the FRAC16 macro.

A.10 frac32_t

The frac32_t type is a signed 32-bit fractional type. It is able to store the variables within the range <-1; 1). Its definition is
as follows:

typedef long frac32 t;

The following figure shows the way in which the data is stored by this type:

Table 75. Data storage

31 24 23 16 15 8 7 0

Value S Fractional

0.9999999995

~
M

F F F F F F

Table continues on the next page...
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Table 75. Data storage (continued)

Library types

-1.0 8 0 0 0 0
0.02606645970 0 3 5 6 2
-0.3929787632 Cc D B 2 D

To store a real number as frac32_t, use the FRAC32 macro.

A.11 acc16_t

The acc16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-256 ; 256). Its definition is

as follows:
typedef short accl6 t;

The following figure shows the way in which the data is stored by this type:

Table 76. Data storage

15 14 13 12 11 10 9 8 7 6 3
Value Sign Integer Fractional

255.9921875 0 1 1 1 1 1 1 1 1 1 1
7 F F

-256.0 1 0 0 0 0 0 0 0 0 0 0
8 0 0

1.0 0 0 0 0 0 0 0 0 1 0 0
0 0 8

-1.0 1 1 1 1 1 1 1 1 1 0 0
F F 8

13.7890625 0 0 0 0 0 1 1 0 1 1 0
0 6 E

-89.71875 1t /1]0|1|o0o|l0|1]1]|]0]o0O 0
D 3 2
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To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

Library types

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables within the range <-65536 ; 65536). Its

definition is as follows:

typedef long acc32 t;

The following figure shows the way in which the data is stored by this type:

Table 77. Data storage

31 24 23 16 15 8 7 0

Value S Integer Fractional
65535.999969 7 F F F F
-65536.0 8 0 0 0 0
1.0 0 0 0 8 0

-1.0 F F F 8 0
23.789734 0 0 B E 1
-1171.306793 F B 6 5 B

To store a real number as acc32_t, use the ACC32 macro.

A.13 FALSE

The FALSE macro serves to write a correct value standing for the logical FALSE value of the bool_t type. Its definition is as follows:

#define FALSE ((bool t)0)

#include "mlib.h"

static bool t bval;

void main (void)
{

bVal = FALSE;
}

/* bvVal = FALSE */
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Library types

A.14 TRUE

The TRUE macro serves to write a correct value standing for the logical TRUE value of the bool_t type. Its definition is as follows:

#define TRUE ((bool t)1)

#include "mlib.h"
static bool t bval;
void main (void)

{
bval = TRUE; /* bval = TRUE */

A.15 FRACS8

The FRAC8 macro serves to convert a real number to the frac8_t type. Its definition is as follows:

#define FRAC8 (x) ((frac8 t) ((x) < 0.9921875 ? ((x) >= -1 ? (x)*0x80 : 0x80) : O0x7F))

The input is multiplied by 128 (=27). The output is limited to the range <0x80 ; 0x7F>, which corresponds to <-1.0 ; 1.0-27>.

#include "mlib.h"
static frac8_t f8val;
void main (void)

{
f8val = FRAC8(0.187); /* f8Val = 0.187 */

A.16 FRAC16

The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is as follows:
#define FRAC16 (x) ((fracl6 t) ((x) < 0.999969482421875 2 ((x) >= -1 2 (x)*0x8000 : 0x8000) : Ox7FFF))

The input is multiplied by 32768 (=215). The output is limited to the range <0x8000 ; 0x7FFF>, which corresponds to
<-1.0; 1.0-21%>,

#include "mlib.h"
static fracle6_t flé6vVal;
void main (void)

{
fl6val = FRAC16(0.736); /* fleval = 0.736 */
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Library types
A.17 FRAC32
The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is as follows:
#define FRAC32 (x) ((frac32 t) ((x) < 1 2 ((x) >= -1 ? (x)*0x80000000 : 0x80000000) : Ox7FFFFFEF))

The inputis multiplied by 2147483648 (=231). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds
to <-1.0; 1.0-2731>.

#include "mlib.h"
static frac32 t f32Val;
void main (void)

{
£32val = FRAC32(-0.1735667) ; /* £32val = -0.1735667 */

A.18 ACC16

The ACC16 macro serves to convert a real number to the acc16_t type. Its definition is as follows:
#define ACCL6(x) ((accl6_t) ((x) < 255.9921875 2 ((x) >= -256 2 (x)*0x80 : 0x8000) : Ox7FFF))

The input is multiplied by 128 (=27). The output is limited to the range <0x8000 ; 0x7FFF> that corresponds to
<-256.0 ; 255.9921875>.

#include "mlib.h"
static accl6_t aléval;
void main (void)

{
aléval = ACC16(19.45627) ; /* alé6val = 19.45627 */

A.19 ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as follows:

#define ACC32 (x) ((acc32 t) ((x) < 65535.999969482421875 ? ((x) >= -65536 ? (x)*0x8000 : 0x80000000)
0x7FFFFFFF))

The input is multiplied by 32768 (=219). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to
<-65536.0 ; 65536.0-21%>,

#include "mlib.h"
static acc32_t a32val;

void main (void)
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a32Val = ACC32(-13.654437); /* a32val = -13.654437 */
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